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1 Welcome to zsDuplicateHunter

1.1 About zsDuplicateHunter
ZsDuplicateHunter allows you to easily find duplicate files including music files, image files, text files, and
binary files. Duplicates can be in a single folder, in multiple folders on one computer, on an entire computer, or
on networked computers.

ZsDuplicateHunter gives you up to eight different methods of determining if two files are duplicates depending
on the edition. The grouping options can be combined so you can precisely control which files are grouped as
duplicates. In the Professional and Enterprise editions, you can even have zsDuplicateHunter perform a binary
check to guarantee that the files are true duplicates.

When you eliminate duplicates from your computer, you will:
· Save space on your hard drive
· Make your computer run faster
· Speed up your backups
· Make searching for files faster

ZsDuplicateHunter provides seven different methods of deleting duplicate files to ensure that there is always an
easy method of deleting the duplicate files you want removed. And, deleting duplicate files is as safe as possible
because zsDuplicateHunter allows you to delete files to a temporary directory and shows you warning messages
before files are permanently deleted.

The Enterprise edition even allows you to replace files with links which let's you save space because the file is
only stored once, but your organization system can remain the same.

ZsDuplicateHunter runs on Mac OS X (10.3 and later), Windows (Windows 2000 or later recommended), and
Linux.

1.2 About this Manual
This manual has been written to give you a better understanding of zsDuplicateHunter so you can get the most
out of the software.

The manual is divided into several sections.  The first section, Getting Started will help you to install
zsDuplicateHunter and it will guide you through a sample duplicate hunt.  The next main section is a How to
Guide which will walk you through some common scenarios that users of zsDuplicateHunter encounter.  The
next section gives a detailed explanation of the zsDuplicateHunter User Interface on a screen by screen basis.
Next, the command line interface is explained.  The command line interface allows you to automate
zsDuplicateHunter.  A section about scripting zsDuplicateHunter using the built in scripting functionality is next
in the manual.  The manual ends with information about obtaining technical support for zsDuplicateHunter.

The screenshots within the manual are a combination of screenshots from Windows, Mac OS X, and Linux.  If a
screenshot does not look exactly like your version of the program, don't worry, it is probably from a different
platform than the one you are using.  The actual screen will be very similar to the screenshot in the manual. 
Also, most screenshots are taken from the Enterprise edition of zsDuplicateHunter.  In some cases where the
screens look very different in the Professional or Standard edition, multiple screenshots will be shown. 
However, in most cases, the Professional or Standard edition will only have one or two controls removed from
the screen.
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1.3 Comparison of zsDuplicateHunter editions
ZsDuplicateHunter is available in three editions Standard, Professional, and Enterprise.

The Standard edition contains the basic functionality required to remove duplicate files from your computer. It
is intended for users that value safety over power.

The Professional edition contains additional ways of grouping duplicate files as well as more powerful tools for
deleting files. It is intended for more experienced users that want additional control of the duplicate hunt process
as well as more powerful tools to quickly delete duplicate files.

The Enterprise edition adds the ability to create scripts within zsDuplicateHunter to automate
zsDuplicateHunter.  It also adds the ability to replace files with links when a file is deleted.  

Feature Comparison Chart
Standard Professional Enterprise

Operating System Compatibility
Runs on Windows, Mac OS X, and Linux

Predefined sets of duplicate hunt options let you quickly switch
settings to the optimal set of options for any situation.  You can also
save new sets of options.

Basic Grouping Functionality
Group by Name, Size, Checksum, and/or Digest

Advanced Grouping Functionality
Group by Path, Extensions, and/or Timestamp

Binary check to guarantee files are true duplicates

Search Networked Drives

Search within Zip files

View duplicates by path or by group

Basic Duplicate Deletion Methods

· Delete Selected Files
· Delete All Duplicates of File
· Delete All Duplicates Except Newest
· Delete All Duplicates Except Oldest

Advanced Duplicate Deletion Methods

· Keep Files in this Folder, Delete Duplicates Elsewhere
· Delete All Files in this Folder Which Have Duplicates
· Delete All Duplicates Except First

Replace Duplicate Files with Links to a shared file
Can be done automatically while deleting files using Link Creation
Rules, or duplicates can be linked to a specific file.

Optionally Delete Files to a backup folder
Which helps to ensure files are not accidentally deleted
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Save Results
HTML
Format

HTML,
XML , and
CSV
Formats

HTML,
XML , and
CSV
Formats

Save and Reload Sessions to quickly repeat commonly used duplicate
hunts.

Extensive Help within help manual and within the program

Additional Advanced Functionality

· Filter files to search using regular expressions
· Ignore aliases and shortcuts when searching for duplicates
· Control the input buffer size to optimize the speed of reading files

Command line interface allows you to automate selected
functionality within zsDuplicateHunter. (Works best on Windows
Operating System)

Create and run Scripts to automate the complete functionality of
zsDuplicateHunter on all operating systems.

Includes a copy of the program on CD with a getting started guide. 
CD includes installations for all operating systems.

Includes a printed user's manual.

1.4 Ordering zsDuplicateHunter

Pricing
All prices for zsDuplicateHunter including volume discount information is available at http://www.zizasoft.com/
products/zsDuplicateHunter/pricing.shtml.

The Order Process
When you are ready to order zsDuplicateHunter, simply select the Buy zsDuplicateHunter Now menu item
within the Help menu, or select the Order Now button on the startup screen or the about dialog.  You can also
purchase directly from the website at http://www.zizasoft.com/store/order.shtml.

On the order form, you can select the product(s) you wish to purchase.  If you have a coupon for
zsDuplicateHunter, you should enter it at this point. 

We accept all major credit cards, PayPal, checks and money orders. 

For online purchases, after you have completed your order, your registration key will be displayed on screen and
you will be e-mailed a copy of the registration key with your receipt as well. 

For offline purchases, your registration key will be sent by e-mail and by postal mail. 

After you have received your registration key, you will need to enter the registration key to activate
zsDuplicateHunter. 

Upgrading Your Program
ZsDuplicateHunter is available in three editions Standard, Professional, and Enterprise.  If you purchase the
Standard or  Professional Edition, you can purchase an upgrade to the Professional or Enterprise version for the
difference in price.  To get the upgrade price, simply select the Purchase Upgrade menu item within the Help
Menu.
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License Types
ZsDuplicateHunter has two different licenses that you can select from depending on your needs. If you require  a
large number of licenses, please feel free to contact our sales team at sales@zizasoft.com for pricing information.

Individual licenses allow the use of zsDuplicateHunter on a single machine. If you wish to use
zsDuplicateHunter on multiple machines, you must purchase a license for each machine. 

A Multi-User license is a cost effective way of purchasing multiple licenses of zsDuplicateHunter to run on
additional machines at the same location.  

All multi-user packs include one copy of zsDuplicateHunter on CD and one user manual with free shipping!
Additional CD's and user manuals can be ordered as needed.

Multi-user packs are priced based on a multiplier or cost factor to the base price of the program. For example,
the cost factor for a 5 user license is 3 which means you receive 5 licenses for the price of three.

Licenses from Multi-User packs may not be re-used or "shared" between households or organizations.

A complete table of multi-user prices is available on our website at http://www.zizasoft.com/products/
zsDuplicateHunter/pricing.shtml. 





Part

II
Getting Started



zsDuplicateHunter  User's Guide8

© 2006 Zizasoft, LLC

2 Getting Started

ZsDuplicateHunter has been designed to be straight forward and easy to use.  This section will help you to install
zsDuplicateHunter and it will walk you through some simple examples to help you to learn the basics of using
zsDuplicateHunter.  There are additional examples in the How to Section of the Help Manual which give more in
depth examples of using zsDuplicateHunter. The functionality available on each screen is described in detail
within the User Interface section of the Help Manual.

2.1 Installing zsDuplicateHunter
The following instructions will help you to install zsDuplicateHunter on your system of choice.  If you have any
questions, please contact us at support@zizasoft.com.

Installation on Mac OS X.
1. Double click on the disk image for Mac OS X. If you are installing from CD, the file will be called: 

zsDuplicateHunter EDITION for Mac OS X.dmg 
where EDITION is the edition being installed (Std, Pro, or Ent) and it is located in the root directory of the CD.
 If you downloaded zsDuplicateHunter from our website, the disk image will be called:

zsDuplicateHunterEDITION_macos_VERSION.dmg 

where EDITION is the edition being installed (Std, Pro, or Ent) and VERSION is the version being installed. 
2. After the disk image opens, the installer will be displayed.  The installer is called zsDuplicateHunter 

EDITION Edition Installer.app where EDITION is the edition being installed (Std, Pro, or Ent).  Double click
on the installer to start it.

3. Select Next on the first screen to start the installation.
4. Please review the software license on the next screen, and if you agree to it, select I accept the agreement and

select the Next button.
5. Select the location where you would like to install zsDuplicateHunter. In most cases, the default is acceptable.

select the Next button.
6. If you do not want zsDuplicateHunter to associate it to the file types, deselect the options.  However, we

recommend associating zsDuplicateHunter with the suggested file extensions.  Select Next to continue the
installation.

7. If you would like an icon created on your desktop, select Create a desktop icon.  Selecting Next will start the
installation. 

8. After the installation is complete, you can optionally have installer automatically start zsDuplicateHunter.

Installation on Windows
1. If you are installing from CD, the installation should start after you insert the CD.  If the installation does not

start automatically and you are installing from CD, double click on the installer which is called:
zsDuplicateHunter EDITION for Windows.exe 

where EDITION is the edition being installed (Std, Pro, or Ent) and it is located in the root directory of the CD.
 If you downloaded zsDuplicateHunter from our website, the disk image will be called:

zsDuplicateHunterEDITION_windows_VERSION.exe

where EDITION is the edition being installed (Std, Pro, or Ent) and VERSION is the version being installed. 
2. Select Next on the first screen to start the installation.
3. Please review the software license on the next screen, and if you agree to it, select I accept the agreement and

select the Next button.
4. Select the location where you would like to install zsDuplicateHunter. In most cases, the default is acceptable.

Select the Next button.
5. Select where you would like the start menu entry to be created.  Again, in most cases, the default is

acceptable. Select the Next button.
6. If you do not want zsDuplicateHunter to associate it to the file types, deselect the options.  However, we

recommend associating zsDuplicateHunter with the suggested file extensions.  Select Next to continue the
installation.

7. If you would like icons created on the desktop or in the Quick Launch bar, leave the appropriate items
checked.  If you do not want the icons created, deselect the appropriate items.  Selecting Next will start the
installation.  

8. After the installation is complete, you can optionally have installer automatically start zsDuplicateHunter.
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Installation on Linux
1. Start the installer by double clicking on the installer.  If you are installing from CD, the installer will be

called::
zsDuplicateHunter EDITION for Linux.sh

where EDITION is the edition being installed (Std, Pro, or Ent) and it is located in the root directory of the CD.
 If you downloaded zsDuplicateHunter from our website, the disk image will be called:

zsDuplicateHunterEDITION_unix_VERSION.sh

where EDITION is the edition being installed (Std, Pro, or Ent) and VERSION is the version being installed. 
2. Select Next on the first screen to start the installation.
3. Please review the software license on the next screen, and if you agree to it, select I accept the agreement and

select the Next button.
4. Select the location where you would like to install zsDuplicateHunter. You will need to have write access to

the selected directory. Selecting the Next button will start the installation.
5. After the installation is complete, you can start zsDuplicateHunter by navigating to the directory where

zsDuplicateHunter was installed and double-clicking the desktop file which was created.  You can also drag
the desktop file to your desktop for easier access.

2.2 Starting zsDuplicateHunter
After you have successfully installed zsDuplicateHunter, you will need to run it.  In most cases, you will have a
shortcut to zsDuplicateHunter on your desktop unless you told the installer not to create a shortcut.  Double click
on the zsDuplicateHunter icon to start zsDuplicateHunter.

After zsDuplicateHunter starts the first time, you will see the splash screen. 

If you have already purchased zsDuplicateHunter, this is a great time to register zsDuplicateHunter by selecting
the Enter Registration Key button.  If you need help entering the registration key, please see the Entering a
Registration Key topic in the user interface section of this manual. 

If you are using the trial version of zsDuplicateHunter, press the Launch button to enter zsDuplicateHunter. 

You should now be at the main screen of zsDuplicateHunter.  The following topic will walk you through a
sample duplicate hunt.

2.3 Sample Duplicate Hunt
This example will walk you through the basics of using zsDuplicateHunter to find and remove duplicate files
from your computer. the majority of this example uses  the main screen of zsDuplicateHunter which is designed
to walk you through the duplicate hunt process step by step.  

This example will use only the features found in zsDuplicateHunter Standard edition except where otherwise
noted. If you are using the Professional or Enterprise Edition of zsDuplicateHunter, you will have access to
additional functionality which is not found in the Standard Edition.  

If you would like to follow along with this example, you can use the sample data provided by Zizasoft.  If you
received zsDuplicateHunter on CD, the sample data is in the Pictures folder within the zsDuplicateHunter
Sample Files folder on the CD.  If you downloaded zsDuplicateHunter, you can get the sample files from http://
www.zizasoft.com/products/zsDuplicateHunter/samples.html. Make sure to copy the files to your local hard
drive and that they can be deleted.

Step 1. Select the folders to search
In the first step, you select the files that you want zsDuplicateHunter to check for duplicates.  

For the purposes of this example select the Pictures folder within the samples directory.  This folder is a small
sample of photos from a digital camera. Some of the files have been categorized according to the contents of the
picture. These categorized files are in the Animals folder. There are also raw files which were downloaded from
the camera. These files have the default name from the camera and are broken up by roll in the Library folder.
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You can select the folder either by pressing the Add Folder to Search button or by dragging the folder from
your system explorer to the list of files to search.

Step 2. Select duplicate hunt options.
In this step, you tell zsDuplicateHunter what criteria you want to use to group duplicate files. This is a necessary
step because different situations call for different criteria to be used.

ZsDuplicateHunter defines several sets of options which you can use, or you can define your own sets of options.
For this duplicate hunt, we will use the default options Exact Duplicates Using Checksum. This set of options
will group any files which have the same contents as duplicates.

Your screen should now be similar to the following.

Initial setup of main screen

Step 3. Start Duplicate Hunt
Press the Start Duplicate Hunt button. This will cause zsDuplicateHunter to begin grouping files to identify
duplicates. You can watch the progress at the bottom of the screen.

Step 4. Review Results
Now that the duplicate hunt is complete, we can review the results. ZsDuplicateHunter offers two methods of
viewing the duplicates, by path and by group. Let's start by looking at the results using the View Results By
Group display.  If the View Results By Group button is not selected, press the View Results By Group button.
You can also set the view mode from the View menu.
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The View By Group view displays all duplicate files together with information about the files. As you can see,
there are 4 groups of files which zsDuplicateHunter has identified as duplicates.

Results of duplicate hunt by group

Let's look at the information zsDuplicateHunter displays about each group. The grouping information will
change based on the options that are selected for the duplicate hunt. For this hunt, zsDuplicateHunter first
displays the number of files within the group. All of the files within the group are duplicates (according to the
criteria you set). After the number of files, zsDuplicateHunter shows the value of the size and checksum that all
of the files in the group share.

Now, let's look at the files within the first group. The first group contains four files. Open the group by double-
clicking on the group. When you open the file, all of the files which are copies of each other are shown.  The full
paths of the files are shown in the first column, and the date that the file was last modified is shown in the second
column. You may need to scroll the results to the right to see the last modified column.  Let's look at each of the
files. As you can see, the files do not all share the same name, and the files also are not all in the same directory.
By reviewing the files, it appears that the same picture was downloaded off of the camera into both the Roll 1
and Roll 2 folders. This happens frequently when downloading files. It also appears that when the pictures were
categorized, that they were categorized under two separate names "Bear "and "Grizzly". Depending on your
categorization system, you may wish to preserve both of these files. The remaining three groups all show a
categorized picture as well as the original file in the Roll 1 folder.

Now, let's look at the same duplicate hunt using the View by Path display mode. Select the View Results By
Path button to switch from viewing by group to viewing by path.After you switch to path mode, you will see the
path which we searched for duplicates in. Open this folder and you will see the Animals and Library folders.
After the folder name, zsDuplicateHunter displays a summary of the files and folders contained in, that folder.
For example, the Animals folder contains eight files. Of the eight files, five of them have duplicates someplace
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else in the results, and three of the files are unique. The Library folder has no files directly within it, but it has
two folders under it. Both folders have 1 or more files in them which contain duplicates. If you open the Library
folder, you can view information about each of the folders within the Library folder.

Results of duplicate hunt by path.

Open the Animals folder and you will see the files which are in the folder. Because we did not elect to include
unique files in the results, only files which have at least one duplicate are shown. The program also displays how
many duplicates of each file exist. For example, the file Bear.JPG has 3 duplicate files. If you expand the file,
zsDuplicateHunter will list the files which are duplicates of Bear.JPG these are the same files that were listed
when we displayed the results by group.

Step 5: Remove Duplicate Files
To remove the duplicates, let's first switch back to viewing the results By Group by clicking on the View Results
By Group button. In the first group, we just want to remove the original files and leave the files which have been
categorized. To do this, we will delete files individually. Open the first group and select the last two files which
are named DSCN1330.JPG. Now, make sure that the selected deletion method is set to Delete Selected Files.
You can now press the Start Deletion button. ZsDuplicateHunter will display a warning that the files will be
deleted permanently. You can also setup the program to delete files to a folder which we will do next. Select OK
to have zsDuplicateHunter delete the files. After the files are deleted, the results will be updated to show that the
files have been deleted. If one or more of the files cannot be deleted for any reason, zsDuplicateHunter will
display a list of the files. If you do receive a message that the sample files could not be deleted, make sure that
the files are not on read-only media like a CD.

Next, let's look at how to delete files to a folder. First, open the options dialog by pressing the Edit Options
button. Now that the Options dialog is open, select the File Deletion tab. To delete files told a folder rather than
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deleting them permanently, select the Delete to Folder option. With this option selected, zsDuplicateHunter will
move any files which are selected for deletion to the folder. By default, ZsDuplicateHunter will create a trash
folder in your user directory. If the deletion folder does not exist, it will be shown in red. ZsDuplicateHunter will
automatically create the folder the first time a file is deleted to the folder.

File deletion options

Now, let's delete any files in the library folder which have already been categorized.  To do this we will switch
back to viewing files by path by selecting the View Results By Path button. The easiest way to do this depends
on which edition of the program you are using. If you are using the Professional or Enterprise editions, you can
select the Animals folder and use the Keep Files In This Folder, Delete Duplicates Elsewhere deletion
method. This allows you to remove all of the duplicates in one easy step. If you are using the Standard Edition,
you would either need to delete the files individually as we did in the first deletion, or if you only wanted to
preserve one copy of the file, you could use the Delete All Duplicates of File deletion method.

At any time while deleting files and reviewing the results, you can open files in their default viewer by first
selecting the file or files you wish to view and then selecting Open in Viewer from the Results menu, or clicking
the Open in Viewer button on the toolbar above the results.

For more information about the other commands which are  available within zsDuplicateHunter, please see the
User Interface section of the User's Guide.
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3 How to...

This section gives you information on how to complete common tasks with zsDuplicateHunter.  For a basic
introduction to finding and removing duplicate files with zsDuplicateHunter, please review the Getting Started
section of this manual.  An in depth explanation of each screen within zsDuplicateHunter is contained in the User
Interface section of the Help Manual.

If you would like to follow along with the examples, you can use the sample data provided by Zizasoft.  If you
received zsDuplicateHunter on CD, the sample data is in the samples folder of the CD.  If you downloaded
zsDuplicateHunter, you can get the sample files from http://www.zizasoft.com/products/zsDuplicateHunter/
samples.html.  

3.1 How to Replace Files with Links
One of the common tasks people use zsDuplicateHunter for is cleaning up multi-user systems where files are
shared among users. When you are working with a multi-user system, you may not want to completely remove a
duplicate file because the user to whom the file belongs will expect the file to be in the original location.

The Enterprise edition of zsDuplicateHunter contains the ability to replace a file with a link. When you replace a
file with a link, your users can work with the file as normal.  In most cases, the file will appear as though it has
not changed to your user.

This example will walk you through the process of creating links to files using zsDuplicateHunter. If you would
like to follow along with this example, you can use the sample data provided by Zizasoft.  If you received
zsDuplicateHunter on CD, the sample data is in the How to Link folder within the zsDuplicateHunter Sample
Files folder on the CD.  If you downloaded zsDuplicateHunter, you can get the sample files from http://www.
zizasoft.com/products/zsDuplicateHunter/samples.html. 

First, we need to setup the information about how to the links should be created. To setup the linking rules, open
the options dialog by pressing the Edit Options button. With the Options Dialog open, select the Link Creation
Rules tab. First, enable the Link Creation by checking the Enable Link Creation checkbox. Next, we will need
to create a rule which maps source directories to destination rules. To add a rule, press the Add Rule button.
You will be prompted for the source directory for the rule. On a multi-user system, the source directory will be
the user directory, or a sub-folder within the user directory. For this example, select the user 1 folder in the
samples  directory and select the OK button. You will now be prompted for the destination directory. This is the
folder that the original file will be placed in. For this example, select the Shared folder in the sample files
directory. There are several options that you can set for the rule. The first option is whether or not the rule
applies to sub-folders within the source directory. The next option is whether or not to preserve the structure of
the source directory when deleting files. The final option is what to do if a file already exists within the
destination folder with the same name as the file being deleted. For this example, we will leave the options at
their default values. If you make a mistake entering a directory name, you can change it by double-clicking on
the directory. Now, setup a second rule using the User 2 directory as the Source and the shared directory as the
destination. All options can be left as the default again. 

When you have finished, the screen will be similar to the following.
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Link Creation Rules - Initial Setup.

Now that we have created the rules, we can continue with our duplicate hunt. Close the options dialog by
pressing the OK button.

To start the duplicate hunt, first remove any folders which are selected to be searched. To remove the folders,
first select the folder and then press the Remove Selected Folders button. We will now select the folders to
search. Select both the User 1 and User 2 folders in the sample data.

For this duplicate hunt, we will use the Exact Duplicates Using Digest - Show Unique Files. This set of options
will group duplicate files by content, and it will also show any unique files in the results so we can work with
them as well. Your screen will be similar to the following.
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Initial setup - Main Screen

After you have selected the correct options, press the Start Duplicate Hunt button.

Let's quickly review the results to form a strategy for replacing the files with links. We will start by looking at the
results by path. As you can see, the two user directories contain the same basic structure.  Each user directory
contains a personnel directory with company wide memos End information. This information does not change
from user to user so we will make sure that each used shares the same information. Each user also has several
project folders which contain information about the projects being worked on. The ABC and AFA projects seem
to be being worked on independently, but the XYZ project is being worked on jointly. When setting up the links,
we will need to ensure that each user's information is correctly preserved. ZsDuplicateHunter helps us with this.

Let's start with the personnel folder as that is the most straight-forward. First, we will need to open the personnel
folder and select the three files in the personnel folder. You can use either the User I or User 2 folder. Now,
select the Replace Selected and Duplicates of Selected With Links command. This command will remove all
of the files in the personnel folder with links to a new personnel folder in the Shared directory. Because the files
are the same in both the User 1 and User 2 directories, both directories will be cleaned up at once.

Because the AFA and ABC projects are not being worked on at the same time, we will leave them alone.

Let's now work on the XYZ project. First, make sure that all files are visible by selecting Show All Files in the
View menu. Now, open the XYZ project folders for both users. 
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XYZ project files

As you can see, the Project Scope document is the same for each user, but the Project Plan is different in each
user folder. In most cases, you would simply want to ensure that the users are aware of the issue and allow them
to correct the problem themselves. However, we will take the opportunity to look at some of the more advanced
features of link creation. Based on our knowledge of our users, User 2 is in charge of the XYZ project so we
would like to give User 2 the documents for the project and allow User 1 to have links to the master copies. 

Let's start by cleaning up the Project scope document as that is the easiest. First, select the Project Scope
document in the User 2 folder. With the Project Plan selected, select the Replace Duplicates With a Link to
Selected command and then start the command. This command will replace any duplicates of the selected file
with a link to the file. So, in this case, user 1 will receive a link to the file in the User 2 folder. 

Now, we can work on the Project Plan document. To replace the Project Plan file in the User 1 folder with a link
to the User 2 folder, we will first want setup a new link creation rule. To do this, first open the Options dialog
and navigate to the Link Creation Rules tab. Now, add a rule with the User 1/XYZ project as the Source
directory and the User 1/XYZ project as the destination directory. We will want to set the Conflicting File option
to enforce that User 2 should have the most up to date version. There are three options that make sense for our
situation. The first option is link to destination which will delete the version in the User 1 folder and create a link
to the User 2 directory, the problem with this is that any changes User 1 has made will be lost. The second option
which is appropriate is the Use Latest Version option which will select the latest version based on the times that
the files were last modified. The final method which is appropriate for our situation is the Add Version Number
to File option. this will store both copies of the file, but it will add a version number so that the files can be
distinguished from each other.  For this example, lets use the versioning option. Now that we have setup this rule,
we need to move it to the top of the list. The rules are evaluated in order and we need to ensure that the new rule
is used rather than the original rules we defined.
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Link Creation Rules with new rule.

Now that the rule is defined, we can delete the file from the User 1 folder. To perform the deletion, first select
the Project Plan document in the User1/XYZ  project folder and delete the file using the Delete Selected Files
method. 



Part

IV
User Interface
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4 User Interface

The user interface of zsDuplicateHunter has been designed to be easy to navigate and easy to learn.
The majority of the functionality of zsDuplicateHunter is contained on the Main screen. The main screen of
zsDuplicateHunter allows you to select folders to search, set options for finding duplicates, start a duplicate
search, and view the results of a duplicate search.

4.1 zsDuplicateHunter Main Screen
The Main Screen of zsDuplicateHunter is the screen that you will use to search for duplicate files, review the
results, and remove duplicate files.  The screen is divided into 5 sections or steps to help guide you through the
process of removing duplicate files.  

zsDuplicateHunter Main Window

Each step is described in more detail in the following sections.

4.1.1 Step 1: Selecting the Folders to Search
When zsDuplicateHunter performs a search, it will search all of the folders listed in the Folders to Search list. 
You add folders to this list by selecting the Add Folder to Search button.  When you add folders to the search
list, you can browse for folders to search either using your system file browser or you can use the custom
explorer built into zsDuplicateHunter.  You can choose between each of these options using the File Browsing
Options in the Options Dialog. You can also drag folders from your system explorer directly to the list.  

ZsDuplicateHunter will automatically remember the folders that you searched last when you close and re-open
zsDuplicateHunter.  
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After you are done searching a folder, you can remove it from the list by selecting the folder or folders that you
wish to remove and then pressing the Remove Selected Folders button.

Please note, all of the folders  in the list will be searched regardless of if they are selected or not. If you do not
wish to search a folder, you must remove it,

4.1.2 Step 2: Setting Duplicate Hunt Options
ZsDuplicateHunter provides several pre-defined options for searching for duplicate files.  You can either select a
pre-defined option for finding duplicate files, or you can define your own options by selecting the Edit Options
button.  Each pre-defined option is explained below.

Option Name Description/Usage Availability

Copies in the Same Folder This option will group any copies of files which are in the same
folder.  It groups by size, checksum, and path.

Professional
and Enterprise
Editions.

Duplicate Images This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by checksum, size,
and file extension.  It also has a filter set to include common
images including ai, bmp, drw, dxf, eps, gif, jpg, jpeg, mng, pct,
png, ps, psd, qxd, qxp, tif, tiff, and wmf.

Professional
and Enterprise
Editions.

Duplicate Music This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by checksum, size,
and file extension.  It also has a filter set to include common music
files including aac, aif, m4a, mid, midi, mpa, mp3, ra, ram, wav,
wma.

Professional
and Enterprise
Editions.

Empty Files This option will find any files which are completely empty (0
size).  This can be useful for cleaning up files which may have
been created but never used.

Professional
and Enterprise
Editions.

Exact Duplicates Using
Checksum

This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by checksum and
size.  Any files which are unique will not be included in the
results. This option is a fast way to find duplicate files where the
contents of the files match.  By not including the unique files, the
results are kept small and easy to understand.

All Editions

Exact Duplicates Using
Checksum - Show Unique
Files

This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by checksum and
size.  Any files which are unique will be included in the results.
This option is a fast way to find duplicate files where the contents
of the files match.  Showing the unique files can help when
deciding which files to keep and they can be very useful when
showing the results by path.

All Editions

Exact Duplicates Using
Digest

This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by digest and size.
 Any files which are unique will not be included in the results. This
option is a slower but more accurate way to find duplicate files
where the contents of the files match.  By not including the unique
files, the results are kept small and easy to understand.

All Editions
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Exact Duplicates Using
Digest - Show Unique
Files

This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by digest and size.
 Any files which are unique will be included in the results. This
option is a slower  but more accurate way to find duplicate files
where the contents of the files match.  Showing the unique files
can help when deciding which files to keep and they can be very
useful when showing the results by path.

All Editions

Exact Duplicates With
Binary Check

This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by checksum and
size.  Any files which are unique will not be included in the
results. This option is a slightly slower way to find duplicate files
where the contents of the files match. It also ensures that files are
truly duplicates by running the binary comparison of each match to
ensure that they are true duplicates. By not including the unique
files, the results are kept small and easy to understand.

Enterprise
Edition

Exact Duplicates Last
Modified at the same time

This option will search the selected folder and all of the sub-
folders in the folder for duplicate files grouping by checksum, size,
and timestamp.  Any files which are unique will not be included in
the results. This option is a fast way to find duplicate files where
the contents of the files match and that were last modified at the
same time.  By not including the unique files, the results are kept
small and easy to understand.

Professional
and Enterprise
Editions.

Exact Duplicates
including files within zip
files

This option will search the selected folder, all of the sub-folders in
the folder, and the contents of zip files for duplicate files grouping
by checksum and size.  

Professional
and Enterprise
Editions.

Files with the same name This option will find files in the selected folder and sub folders
which have the same names but not necessarily the same contents.
Care needs to be taken when using this set of options as the files
may have different data within them.

Professional
and Enterprise
Editions.

4.1.3 Step 3: Starting the Duplicate Hunt
Once you have chosen the folders to be compared and the options for comparison, click the Start Duplicate
Hunt button to run the comparison. You may check the status of the comparison using the status bar on the
bottom of the program window. If, for any reason, you need to stop the program while it is running, click on the
Cancel button in the bottom right hand corner.

Once the program has finished running there will be a summary of results in the status bar at the bottom of the
window. This will tell you at a glance how many duplicates were found during the comparison.

4.1.4 Step 4: Reviewing the Results
The results section occupies the lower portion of the right side of the screen in zsDuplicateHunter. This section
describes the results to help you understand and modify the display.

4.1.4.1 View Duplicates by Path

zsDuplicateHunter has offers you two methods of displaying duplicates. The first type of display is display by
path. This display type shows duplicates based on the path where the original file is located. The second type of
display is display by group. This display type displays duplicates according to the criteria you set for grouping.
In both cases, the Timestamp of each file is displayed to help you determine which files you want to preserve and
which files you want to delete. The format of the timestamp can be customized using the options dialog.
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In the display by path view, all folders that were searched for duplicates are displayed just as they exist within
your file system. After each file and folder, a summary of the status of the file and folder is displayed. For a
folder, this status tells you how many files exist within the folder as well as how many of the files are unique and
how many have duplicates. The status also tells you how many sub folders exist within the folder and how many
of the sub folders have duplicates. For each file, there is a summary describing how many duplicates were found
for the file.

In the example above, the BIRDS directory has 10 directories under it all of which have one or more duplicate
files within them. The BIRDS directory has no files in it. The FLIGHTLESS directory has a total of 57 files in it.
13 of the files have one or more duplicates in the area that was searched and 44 of the files have no duplicates.
The file 1993516.WMF has one duplicate in the area that was searched. The full path of the file is listed under
the file.

Only duplicates which meet all the criteria you specified for the duplicate hunt are listed. Partial matches are not
listed in the results.

Unique files are only listed if the Include Unique Files in Results setting was turned on when the duplicate hunt
was run and Show All Files is turned on in the View menu.

When you open a file, a list of all files in that group will be displayed with the full path of the file. You can use
the full path to identify which duplicate you would like to preserve and which duplicates can be safely deleted.
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4.1.4.2 View Duplicates by Group

When you have set the zsDuplicateHunter to display duplicates by Group using the View menu,
zsDuplicateHunter will display groups of duplicates based on the criteria you set for grouping.

Each group that is displayed will be described with the number of duplicates found and a list of which criteria
matches for the files in the group. If you have selected more than one option to group on, zsDuplicateHunter may
create nested groups.

For example, in the picture above zsDuplicateHunter found 3 files that were of size 17082 bytes and a checksum
of E8740CA. Because the size and Checksum are the same, all 3 files are true duplicates of each other.

When you open a group, a list of all files in that group will be displayed with the full path of the file as well as
the timestamp. You can use the full path and timestamp to identify which duplicates you would like to preserve
and which duplicates can be deleted.

4.1.4.3 File Information and Preview

When you select a file or folder, zsDuplicateHunter will display information about the file or folder which has
been selected.  This information includes the size of the file, when the file was last modified, the file attributes
and more. If the file is an image which zsDuplicateHunter can recognize, a thumbnail of the image will also be
displayed.

4.1.4.4 Sorting the Results

To help you easily review the results of your duplicate hunt, zsDuplicateHunter allows you to sort the results.

Sorting Files
ZsDuplicateHunter allows you to sort duplicate files within groups both while viewing duplicates by group and
while viewing duplicates by path. There are three methods of sorting files available. You can choose between the
methods on the View menu.

Sort Files by Time Ascending
This method sorts files according to timestamp with the earliest file displayed first.

Sort Files by Time Descending
This method sorts files according to timestamp with the earliest file displayed last.

Sort Files by Name
This method sorts files according to the path where the file exists.

Sorting Groups
There are two methods of sorting the groups of results. These methods are available only when duplicates are
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displayed by group. You can sort the results according to number of duplicates, or you can sort the results
according to the Grouping Information. You can change the Sort Method on the View Menu.

Sort Groups by Number of Duplicates
Sorting by Number of Duplicates sorts the results so the group with the most duplicates is displayed first and the
group with the least duplicates is displayed last. This is very useful when you are trying to speed up your
computer by removing unused duplicates because you can concentrate on groups that have large numbers of
duplicates.

Sort Groups by Grouping Information
Sorting by Grouping Information will do a smart sort of the groups depending on the options you have selected.
This option is useful when you want to review the groups without worrying about the total number of duplicates
in each group.

4.1.4.5 Filtering the Results

There are two options for filtering results in zsDuplicateHunter. Filtering options can be selected from the View
menu. You can choose to filter so the results only Show Duplicates, only Show Unique Files, or you can filter the
results to show All Files. In most cases, you will want to show Duplicates Only. However, it can be useful to
show all files from time to time.  For some file management tasks, you may want to only show unique files.

Note: if the Include Unique Files in Results option was turned off when you ran the duplicate hunt, you will not
be able to see unique files even when the Show All Files setting is on.

4.1.4.6 Selecting Results

In order to delete duplicate files, you will first need to select the results you want to work with. The easiest way
to select a single file is to simply click on it. If you would like to select several files you can hold the Control key
in Windows and Linux or the Command key on Mac OS X and select the files you want. To select several files in
a row, select the first file and then hold the Shift key while you select the last file.

In addition to the standard selection methods, zsDuplicateHunter offers several shortcuts for selecting files.
These options can be accessed from the Results menu, or from the Results context menu which can be accessed
by right clicking on a result in Windows and Linux and control clicking on a result in Mac OS X.

To select all files within a group, use the Select All Files in Group menu item. To select all files except the
currently selected file, use the Select All Files in Group Except Current.

You can also easily deselect all files or all files within the current group using the Results menu.

4.1.4.7 Expanding and Collapsing Groups

To navigate the results, you will need to expand and collapse the groups of duplicates.

The easiest ways expand or collapse a group is to click on the expansion symbol to the left of the icon (Arrow on
Macintosh systems, Plus Minus on Windows systems) or double-click on it.

You can also use the Results Menu to Expand All Groups expand the currently selected Group and all of it's
children, or Collapse All Groups. These options are also available on the Results Context menu which can be
accessed by right clicking on a result in Windows and control clicking on a result in Mac OS X.

4.1.5 Step 5: Removing Duplicate Files
After zsDuplicateHunter has grouped the files you have selected, you can delete duplicate files to recover lost
disk space and speed up your computer. zsDuplicateHunter provides seven different options for deleting files.
Each method has different uses depending on your needs and should be used in different situations.

You can control whether files are permanently deleted or deleted to a backup folder by using the Delete Options
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which can be accessed using the Options menu item on the File menu.

If you have selected all items in a group, a warning will be issued to ensure you do not delete all copies of a file
inadvertently.

If a file cannot be deleted for any reason, it will be listed in a warning dialog so you can manually delete the
item. Common reasons for not being able to delete a file include the file being in use, and not having sufficient
permissions to delete the file.

In the Options Dialog, you can choose whether or not zsDuplicateHunter should remove any folders that are
completely empty after zsDuplicateHunter deletes duplicate files. You can also determine whether or not files
which contain only hidden files should be treated as empty.

All Deletion methods can be accessed from the Results menu, the Context menu, and by selecting the deletion
method from the list of Deletion methods and then pressing Start Deletion.

Note: Some deletion methods are available only in the Professional and Enterprise editions.

4.1.5.1 Delete All Files In This Folder Which Have Duplicates

This command is useful when you want to remove all files which have duplicates within a folder and leave the
files elsewhere alone. This command will preserve only files that are not in the selected folder. This command is
potentially unsafe if all duplicates of a file are contained within the path you have selected. In this case, you will
be presented with a warning message.

The Delete All Files In This Folder Which Have Duplicates command is only available when you are in Display
By Path mode and you have selected a folder which has duplicates under it.

To use this command, use the following procedure.
1. Run a Duplicate Hunt to generate results.
2. Select a folder with duplicates in view by path mode.
3. Right Click on the item and select the Delete All Files In This Folder Which Have Duplicates command, or

select the Delete All Files In This Folder Which Have Duplicates command from the results menu.

The items will be automatically deleted, and the results will be updated.

This deletion method is only available in the Professional version.

4.1.5.2 Deleting Selected Files from the Results

Deleting Selected Files is useful when you want to delete a small number of files at one time. To delete selected
files, use the following procedure.

1. Run a Duplicate Hunt to generate results.
2. Select the file or files you wish to delete.
3. Run the Delete Selected Files deletion method, or press the Delete Key on the keyboard.

The items will be automatically deleted, and the results will be updated.

If there are no items selected the Delete button will not be available. Deleting selected files is available when
viewing duplicates by group and when viewing duplicates by path.

4.1.5.3 Delete All But Newest Duplicate

The Delete All But Newest File command is useful when you have a group of duplicates where you are not
concerned with preserving a directory structure. This command will preserve only the most recently modified
file. This command is a safe command and you will not be able to delete all occurrences of a file using this
command.
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The Delete All But Newest File deletion method is only available when a group has been selected which has
duplicate files in it.

To use this command, use the following procedure.
1. Run a Duplicate Hunt to generate results.
2. Select a group of files (in either view by path or view by group mode).
3. Run the Delete All But Newest File deletion method.

All files except the newest file will be automatically deleted (leaving one file remaining) and the results will be
updated.

4.1.5.4 Delete All But Oldest Duplicate

The Delete All But Oldest File command is useful when you have a group of duplicates where you are not
concerned with preserving a directory structure. This command will preserve only the oldest file. This command
is a safe command and you will not be able to delete all occurrences of a file using this command.

The Delete All But Oldest File deletion method is only available when a group has been selected which has
duplicate files in it.

To use this command, use the following procedure.
1. Run a Duplicate Hunt to generate results.
2. Select a group of files (in either view by path or view by group mode).
3. Run the Delete All But Oldest File deletion method

All files except the oldest file will be automatically deleted (leaving one file remaining) and the results will be
updated.

4.1.5.5 Delete All But First Duplicate

The Delete All But First File command is useful when you have a group of duplicates where you are not
concerned with preserving a directory structure. This command will preserve only the first item in the group. The
first item is dependent on the sorting you have set. This command is a safe command and you will not be able to
delete all occurrences of a file using this command.

The Delete All But First File command is only available when you are in View By Group mode and a group has
been selected which has duplicate files in it.

To use this command, use the following procedure.
1. Run a Duplicate Hunt to generate results.
2. Select a group of files in view by group mode.
3. Run the Delete All But First File deletion method.

The items will be automatically deleted, and the results will be updated.

This deletion method is only available in the Professional version.

4.1.5.6 Delete All Duplicates Of File

The Delete All Duplicates of File command is useful when you have a group of duplicates and you know exactly
which file you wish to preserve. This command will preserve only the selected file. It is faster than opening a file
group, selecting all of the files within the group, and deleting them. This command is a safe command and you
will not be able to delete all occurrences of a file using this command.

The Delete All Duplicates of File command is only available when you are in Display By Path mode and you
have selected a file which has duplicates under it.

To use this command, use the following procedure.
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1. Run a Duplicate Hunt to generate results.
2. Select a file with duplicates in view by path mode.
3. Run the Delete All Duplicates deletion method.

The items will be automatically deleted, and the results will be updated.

4.1.5.7 Keep Files In This Folder, Delete Duplicates Elsewhere

The Keep Files In This Folder, Delete Duplicates Elsewhere is useful when you want to preserve the files within
a specific directory, but want to remove the duplicate files from everywhere else. This command will
automatically remove any duplicates of the files in the folder you have selected preserving the files in the
selected directory and it's sub-folders. This command is a safe command and you will not be able to delete all
occurrences of a file using this command. There may be some duplicates remaining after you execute this
command if there are multiple copies of the file within the path you have selected.

The Keep Files In This Folder, Delete Duplicates Elsewhere command is only available when you are in Display
By Path mode and you have selected a folder which has duplicates under it.

To use this command, use the following procedure.
1. Run a Duplicate Hunt to generate results.
2. Select a folder with duplicates in view by path mode.
3. Right Click on the item and select the Keep Files In This Folder, Delete Duplicates Elsewhere command, or

select the Keep Files In This Folder, Delete Duplicates Elsewhere command from the results menu.

The items will be automatically deleted, and the results will be updated.

This deletion method is only available in the Professional version.

4.1.5.8 Replace Selected and Duplicates of Selected With Links

This command will cause zsDuplicateHunter to replace the selected file or files with links according to the Link
Creation Rules defined in the options. Any duplicates of the selected files will also be replaced with links.This
command is a quick way to replace multiple files with links in one easy step, or to replace single unique files
with links. You can also selectively replace files with links using the delete selected method. The command is
available for both unique files as well as files with duplicates.

To enable the start command button, select any file in either by path or by group view. The file you select must
have duplicates.

The Replace Selected with Links command is only available in the Enterprise edition of zsDuplicateHunter.

4.1.5.9 Replace Duplicates With a Link to Selected

This command allows you to replace all duplicates of the selected file with a link to the selected file. The
duplicate files will be removed and a link will be created in their place. The link will point directly to the
selected file. The selected file will not be moved.

To enable the start command button, select a file within the View by Path or View by group display.

This command is only available in the Enterprise edition.

4.1.6 Additional Ways to Work with Results
After zsDuplicateHunter has searched the folders you have selected for duplicate files and grouped them, you
can work with the results to remove duplicate files or to do further investigation into files. This section describes
several ways you can work with the results beyond deleting files.
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4.1.6.1 Replacing Files with Links

The Enterprise Edition of zsDuplicateHunter allows you to replace a file with a link to a shared file rather than
completely deleting the original.  This is very useful when multiple users have access a computer and each user
has a copy of files.  Rather than keeping several copies of the files or making the users change the way they store
the information you can replace the file with a link. 

4.1.6.2 Ignoring Results

Ignoring results allows you to easily remove one or more files or folders from the results. This causes
zsDuplicateHunter to not show the file anywhere within the results and to not include the file in any of the totals.
You should use this functionality when you have identified files which you want to keep even though they may
be duplicates of other files.

Ignore Selected
This command will remove only the files which you have selected from the results. The Ignore Selected
command is available whenever you have selected at least one file or folder within the results.

Ignore Selected and Duplicates of Selected
This command will remove the files you have selected as well as any duplicates of those file. This command is
very useful when you want to preserve all copies of a specific file. The Ignore Selected and Duplicates of
Selected command is available in View By Path mode when you have selected a File or Folder which has
duplicates under it.

4.1.6.3 Opening Files and Folders from the Results

ZsDuplicateHunter allows you to open files and folders from the results in an external viewer if there is one
available. This is very useful if you need to confirm any changes between two files that have the same name but
different contents. There are three different ways you can open files and folders. Each of which is explained in
more detail below.

Open In Viewer
This command opens the file(s) you have selected in the default viewer for that type of file. This command is
available in the results menu and the context menu whenever you have a file or folder selected in the results.
1. First find duplicates to generate the results.
2. Locate the file you would like to open in the results (only one file at a time can be opened).
3. Right click on the file and select "Open in Viewer" from the context menu. zsDuplicateHunter will attempt to

load the file in its associated viewer. If zsDuplicateHunter is unable to launch a viewer, an error message will
be displayed.

If the selected file resides in a zip file, zsDuplicateHunter will extract the file to a temporary directory. If you
make changes to the file, make sure to save the file to a new location.

If you make changes to a file, the results will not be reloaded automatically and you will need to run the search
again.

Open Containing Folder
This command opens the folder(s) which contain the file(s) you have selected in your system file browser. This
command is available in the results menu and the context menu whenever you have a file or folder selected in the
results.

Open Folders Containing Duplicates
This command opens the folder(s) which contain the duplicates of the file(s) you have selected in your system
file browser. This command is available in the results menu and the context menu whenever you have a file or
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folder selected in the results. Note: This command has the potential to open a large number of windows if you
have a large number of duplicates.

4.1.6.4 Clear Results

ZsDuplicateHunter allows you to clear the results by selecting the Clear Results menu item.  This will remove the
current results from the display, and reset the duplicate hunter to it's default state.

4.2 Searching within the Results
The Find Dialog allows you to search the results of a Duplicate Hunt. To access the Find Dialog, select Find
from the results menu. 

The find dialog offers several options to make searching more efficient. Each option is described below.

Search In
The search in list provides a list of all locations that can be currently searched. To include an area, simply select
it. To exclude an area, de-select it.

Find
This drop down list allows you to determine what to search for. For your convenience, items you have searched
for previously (since starting the program) are remembered so you can easily repeat a search.

Options

Whole Words Only
The Whole Words Only option forces any matches to be a complete word and avoids partial matches. For
example, using a whole word only match with ana will match ana, but not banana or anagram. This option is not
available when doing regular expression searches.
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Match Case
The Match Case option forces any matches to match the case of the text you have typed in the Find list. For
example, using match case with Zizasoft will match Zizasoft, but not zizasoft or ZizaSoft. This option is not
available when doing regular expression searches.

Use Regular Expressions
Regular Expressions allow you to do powerful comparisons of text. For more information on using regular
expressions, see the next section Understanding Regular Expressions.

Search Up
The Search Up option will search from the current selection toward the start of the results when Find Next is
selected.

Search Down
The Search Down option will search from the current selection toward the end of the results when Find Next is
selected.

Find Next
The Find Next button searches the results from the current selection in the direction specified by the Search Up
and Search Down options. If a match is found, it is selected. If no match can be found, the program will report
"Text not Found".

Find All
The Find All button searches the entire document (regardless of the selected direction). All matches will be
selected in the results and listed in the search results section. If no matches can be found, the program will report
"Text not Found".

Search Results
The Search Results section lists all matches for a given search. You can easily jump to a specific match by
simply clicking on the item in the list.

4.3 Working with Duplicate Hunt Reports
ZsDuplicateHunter allows you to save and print HTML reports of the results of your duplicate hunt. In the
professional version of zsDuplicateHunter, you can also save XML reports. This section describes how to save
reports and change report options to customize your report.

4.3.1 Saving HTML Reports
To save HTML reports, simply run a duplicate hunt and then select Save HTML Report from the File menu. You
will be presented with an options dialog which allows you to customize the report to your liking. Each option is
described in more detail in the following section. After you have set the options the way you want, press the ok
button. You will now be prompted for the location you wish to save the report to. Choose a location and the
report will be saved. If you have selected the View Report after Creation option, a browser will be opened
containing the report. You can print the report from the browser.

To reopen a report after it has been saved, use the web browser that comes with your computer.
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4.3.2 Duplicate Hunt Report Options

Report Options Dialog

Title Text
The title text allows you to set the title of the report. The title will appear at the top of the report, and as the name
of the document in your browser.

Header Text
The header text appears at the top of the report before any of the information generated automatically be
zsDuplicateHunter. You could use this area to describe the duplicate hunt so you can easily recall the purpose of
the duplicate hunt later. You may use any HTML codes you want to within this section to format the text.

Include Options Used
If this option is turned on, the options used during the duplicate hunt will be printed. Each option is printed on
it's own line and followed with on or off to indicate the status. Including this information in the report will help
you to repeat the duplicate hunt in the future.

Include Directories Searched
If this option is turned on, a list of all directories that were selected while running the duplicate hunt will be
printed. Including this information in the report will help you to repeat the duplicate hunt in the future.

Include Visible Results Only / Include All Results
This option will determine whether zsDuplicateHunter prints the results as displayed on the screen or if all results
that have been generated will be printed. In most cases you will want to use the Include Visible Results Only
option. However, the Include All Results is a quick shortcut to print everything without modifying your filters.



User Interface 35

© 2006 Zizasoft, LLC

Include Table Borders
If this option is turned on, the results table will have borders around each cell. If it is turned off, the borders will
not be shown. This option is a matter of personal preference.

Include Date Printed
If this option is turned on, the date will be included in the footer of the report.

Font Size
This option allows you to set the relative size of the text from xx-small to xx-large. A medium size format is
normally appropriate.

Footer Text
The footer text appears at the bottom of the report after all of the information generated automatically be
zsDuplicateHunter. You could use this area to describe the duplicate hunt so you can easily recall the purpose of
the duplicate hunt later. You may use any HTML codes you want to within this section to format the text.

View Report after Creation
If this option is turned on, the report will be opened in your web browser after it has been created. You can print
the report from the browser.

4.3.3 Saving Results to XML
The results of a duplicate hunt can be saved in XML format by using the Save Results to XML menu item in the
File menu.

When you select this option, you will be prompted for a filename to save to and then zsDuplicateHunter will save
the results in an XML format.

The Results File contains information about the options used for the duplicate hunt and a detailed listing of the
results.

Saving to XML is available only in the professional version of zsDuplicateHunter.
.

4.3.4 Exporting Duplicates to a CSV File
The Professional and Enterprise Editions allow you to export the results of a duplicate hunt to a CSV file.  This
file will export any duplicate files by group to a file.  You can use this file to import the duplicate information
into another program or to create custom reports for the duplicate information.  

The format of the file is as follows:
Group #,# of Files in Group,Group Description 
File #,File path

Some sample data would be:
Group 1,9,"9 files with a size of 61 bytes, and a checksum of 57359E3E"
File 1,C:\Downloads\WackoWiki\wacko.r4.2\themes\coffee\css\.htaccess
File 2,C:\Downloads\WackoWiki\wacko.r4.2\themes\coffee\icons\.htaccess
File 3,C:\Downloads\WackoWiki\wacko.r4.2\files\.htaccess
File 4,C:\Downloads\WackoWiki\wacko.r4.2\js\.htaccess
File 5,C:\Downloads\WackoWiki\wacko.r4.2\images\.htaccess
File 6,C:\Downloads\WackoWiki\wacko.r4.2\themes\default\css\.htaccess
File 7,C:\Downloads\WackoWiki\wacko.r4.2\themes\default\icons\.htaccess
File 8,C:\Downloads\WackoWiki\wacko.r4.2\themes\tabs\css\.htaccess
File 9,C:\Downloads\WackoWiki\wacko.r4.2\themes\tabs\icons\.htaccess
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Group 2,6,"6 files with a size of 0 bytes, and a checksum of 0"
File 1,C:\Downloads\WackoWiki\wacko.r4.2\themes\coffee\appearance\footermsword.php
File 2,C:\Downloads\WackoWiki\wacko.r4.2\themes\coffee\appearance\footerprint.php
File 3,C:\Downloads\WackoWiki\wacko.r4.2\themes\default\appearance\footermsword.php
File 4,C:\Downloads\WackoWiki\wacko.r4.2\themes\default\appearance\footerprint.php
File 5,C:\Downloads\WackoWiki\wacko.r4.2\themes\tabs\appearance\footermsword.php
File 6,C:\Downloads\WackoWiki\wacko.r4.2\themes\tabs\appearance\footerprint.php
Group 3,3,"3 files with a size of 651 bytes, and a checksum of 2222AFD1"
File 1,C:\Downloads\WackoWiki\wacko.r4.2\themes\coffee\css\wakkamsword.css
File 2,C:\Downloads\WackoWiki\wacko.r4.2\themes\default\css\wakkamsword.css
File 3,C:\Downloads\WackoWiki\wacko.r4.2\themes\tabs\css\wakkamsword.css

To parse the file, you will need to read each group line to find the number of files in the group.  You can then
read each file.  The filename always extends from the first comma on the line to the end of the line.  

4.4 Saving and Loading Sessions
Sessions allow you to save and re-run common duplicate hunts.

A session file stores information about the folders which are being searched as well as the options used for the
duplicate hunt. Sessions are saved with a .zsDH extension.

To save a session, select Save Session from the File menu. You will be prompted for a filename to save to, and
zsDuplicateHunter will then save the file.

To load a session, select Load Session from the File menu. You will be prompted for a filename to load. After
selecting the file to load, zsDuplicateHunter will load the settings and update the screen.

For your convenience, the last 5 sessions used are stored at the end of the File menu. To reload these sessions,
simply click on the menu.

Sessions are only available in the professional version of zsDuplicateHunter.

4.5 File and Folder Selection
Within zsDuplicateHunter there are various locations where you will need to select a file or folder.  In the places,
you will see a control which looks like the image below.  The text to the left of the filename will change to
describe what will need to be selected.

File Selection Window

For example, before starting a file or folder comparison, you will need to first select the files to compare. 
ZsCompare gives you several methods of selecting files.  You can type the name directly, drop files from your
file system onto the selection window, browse for files using your system explorer, browse for files using our
custom explorer, or select files from the favorites.

Each method of selection has it's strengths and weaknesses, so selecting the best method of selecting a file or
folder will depend on your personal preferences.  Each method of selecting a file or folder is described in more
detail in the following pages.

4.5.1 Typing Names
If you already know zsDuplicateHunter name of the file, zsDuplicateHunter allows you to simply type the name
in the selection window.  As you type, zsCompare will determine if the name you have entered is valid for the
current situation. If the name is invalid, the text will turn red.

Invalid File Name Selected
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If you using zsDuplicateHunter on Windows or on Mac OS X, you can also drag a file to the selection window
from your file system.  Therefore, on Windows you can drag a file from Windows Explorer to the selection
window and on Mac OS X you can drag a file from Finder to the selection window.  If you attempt to drag a file
to the selection window when a folder is required or vice versa, zsDuplicateHunter will warn you and it will not
complete the operation.

4.5.2 Favorites
ZsDuplicateHunter stores files and folders that you have accessed using the explorer in the favorites list. This is
useful then you work with a small number of files and folders on a regular basis, and do not want to take the time
to navigate through the explorer repeatedly to find the same things. The favorites list can be accessed by
selecting the Favorites button on the Selection Window.  

Favorites Window

By default, the favorites are sorted by path.  However, you can also choose to sort the favorites by when they
were last used or by the frequency of use.  You can select a Favorite by double clicking on an entry, or by
selecting an item and then selecting the OK button.
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If you wish to remove one or more files from the favorites list, you can simply select the file or files you wish to
delete and then select the Delete Favorite button.

You can prevent zsDuplicateHunter from saving favorites using the Browse Options which are located in the
options dialog.

4.5.3 System Explorer
zsDuplicateHunter allows you to use the system file dialog (Windows Explorer on Windows and Finder on Mac
OS X) when selecting files and folders to browse if you prefer this dialog to the custom dialog built into
zsCompare. The primary advantage to using the custom explorer is that you will be able to browse the contents
of zip files and jar files.

To use the system dialog in Windows, select the Browse Using Windows Explorer option in the Browse Options
within the Options dialog.

To use the system dialog in Mac OS X, select the Browse Using Finder option in the Browse Options within the
Options dialog. We have attempted to replicate the Finder browse dialog as closely as possible. However, there
are still some differences.  If you find the differences to not be to you liking, you can use the custom explorer
instead. 

On Linux Systems, the system explorer will allow you to browse using a window which displays the files in a
non-hierarchical manner.
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4.5.4 Custom Explorer
The file and folder explorer allows you to select files and folders from a hierarchical view of your computer. To
access the explorer, press the Browse button.

Custom Explorer Window

The explorer contains a tree which lists all of the directories on your computer. To make the tree as easy to
navigate as possible, the files and folders are displayed hierarchically as they occur within the file system. Zip
files and Jar Files are displayed as folders so they can be used in comparisons and so the contents can be
browsed.

The way that the files are presented will depend upon your operating system.  However, in all cases there will be
a root directory which contains files and folders underneath it.  In Windows, the root folder is called My
Computer.  In Mac OS X and Linux it is /.  To find networked computers on Windows systems, look under the
My Networked Places folder under the Desktop folder.  On Mac OS X, look under the Volumes Directory which
will be listed under the / folder.  On Linux systems, networked computers will generally appear under the mnt
directory.

You can select a file either by clicking on it and then pressing OK, or by double clicking the file you want to
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select.

The toolbar items allow you to refresh a selected item, refresh the entire tree, create a new file, create a new
folder, and delete the selected file or folder.  These commands are also available on the context menu which is
accessed by right clicking on a file or folder.  The context menu will also allow you to create Zip Files and Jar
Files.

4.5.4.1 Creating Files and Folders

After you select the Create File, Create Folder, Create Zip File, or Create Jar File option to determine what you
would like to create, you will be prompted for a name. Simply enter the new name and zsDuplicateHunter will
create the new file, folder, zip file, or jar.

When you create a zip file, the name must end with .zip. If you do not add the .zip extension, zsDuplicateHunter
will automatically add it for you. Similarly, when you create a jar file, the name must end with .jar. If you do not
add the .jar extension, zsDuplicateHunter will automatically add it for you.

zsDuplicateHunter does not currently allow you to create files and folders within Zip Files or Jars from the
Explorer. You may add files and folders to Zip Files and Jars by comparing the Zip File or Jar to the source files
and then copying the appropriate items into the Zip File.

4.5.4.2 Deleting Files and Folders

You may delete an item from the Custom Explorer and then selecting the Delete button or by selecting the delete
command from the context menu.  After you start the delete command, zsDuplicateHunter will display a
confirmation prompt which allows you to cancel the deletion. If you select ok to the prompt, the item you
selected will be permanently deleted.

Note: zsDuplicateHunter does not currently allow you to delete files or folders within Zip Files or Jars from the
explorer. You may delete files and folders from Zip Files and Jar Files by using the delete command in the
results section.

4.6 Options Dialog
There are several general options available in zsDuplicateHunter that allow you to modify the behavior of
zsDuplicateHunter. These options can be set on the Options dialog which can be accessed from the Options
menu item in the File menu. On Mac OS X, you can also access the options dialog using the Preferences item in
the zsDuplicateHunter menu. Note: some options are available only in the Professional or Enterprise version of
zsDuplicateHunter.
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4.6.1 Browse Options

File Browsing Options Dialog

ZsDuplicateHunter offers two methods of browsing for files. You can either browse using a custom explorer
which will allow you to explore and compare the contents of zip files and jar files. Or, you can browse using
the system explorer native to your operating system (Explorer on Windows, Finder on Mac OS , and Konqueror
on Linux). By default the browser specific to your system is enabled.  

If you are using the custom browse dialog, zsCompare allows you to control which files are displayed in the
dialog. You can optionally show system files and show hidden files.  Hiding system and hidden folders helps to
clean up the display and helps to protect important system files. We suggest that in most cases, you leave these
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settings off.  

The Remember Favorites setting is used to control whether or not zsDuplicateHunter will remember the files
and folders which have been used last.  If you disable this setting, the Favorites button will not be available and
you will not be able to select favorites.  In most cases, you will want to leave this setting on.

The Remember Last Used Paths determines whether or not zsDuplicateHunter remembers the last files and
directories you compared.  If this setting is off, the main screen will always have empty selections for the left and
right files and folders when you start zsDuplicateHunter.

4.6.2 File Deletion Options
zsDuplicateHunter allows several options for file deletion. These options are intended to make deleting files as
safe as possible and to prevent inadvertently deleting files permanently.

File Deletion Options Dialog

Deleting Permanently and Deleting to Folder
The delete to folder option allows you to move files to another directory rather than having them deleted
permanently. This can be very useful to ensure that you have a backup of all files before deleting them
permanently. If the directory you have chosen to delete the files to does not exist, it will be created automatically
when a file is deleted.
When deleting files to a folder, you can optionally remember the path of the files. When this option is turned on,
zsDuplicateHunter will record the path to each file in a series of folders. We highly recommend that you leave
this setting on because it can make recovering from an accidental deletion significantly easier.

Warn when deleting a file permanently
Turning this option on causes a warning screen to be displayed whenever a file will be permanently deleted.
When the warning is displayed, you are given an opportunity to cancel the deletion or continue with the deletion.
For your convenience, if you have selected multiple files for deletion, only one dialog will be displayed list all of
the files. This eliminates the need to click through many dialog boxes when deleting several files.

Automatically Delete Folders When All FIles Have Been Deleted
Turning this setting on signals to zsDuplicateHunter that you would like to have folders deleted when they are
empty. With this setting on zsDuplicateHunter will automatically detect when you have deleted all files and
folders within another folder from zsDuplicateHunter, and it will automatically delete the parent folder. If you
have the Treat Folders With Hidden Files Only As Empty setting on, zsDuplicateHunter will delete folders
when all visible files are removed.
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4.6.3 Link Creation Rules
The Link Rule options are available in the Enterprise Edition of zsDuplicateHunter.  Link Rules allow you to
have zsDuplicateHunter replace files which will be deleted by links or aliases after the files are deleted.  

Link Creation Rules Dialog

Enabling Rules
In order to enable the creation of links, you must first check on the Linking Enabled checkbox.  If this checkbox
is turned off, then zsDuplicateHunter will make no attempt to create links when deleting files.

Link Creation Rules
Link Creation Rules specify how files within a folder are handled.  Link Creation Rules are handled in the order
they appear in the list so the first rule that is matched will be used.  This allows you to handle files in a sub-folder
differently than files within a parent directory. You can move rules up and down in the list to ensure they are in
the correct order.

For each rule, you must specify the following items:
1. Source Directory - Specifies the directory which files will be removed from and replaced with links.
2. Include Sub Folders - Specifies whether or not any files which are located in sub folders of the source

directory should be handled with this rule.  By default, this is turned on.
3. Destination Directory - Specifies the directory where the original file should be moved to if it does not

already exist.  After moving the source file, a link will be created from the source directory to the Destination
Directory.

4. Preserve Directory Structure - Specifies whether or not the directory structure of the source directory
should be preserved when moving files to the destination directory or if files should be placed directly within
the destination directory regardless of if they originally were in a sub-folder of the source directory.

5. Conflicting File Action - Specifies what zsDuplicateHunter should do if a file already exists in the
Destination Directory with the same name as the file being deleted, and the existing file is not exactly the
same as the file being deleted.  Valid values are: Use latest version, Cancel Deletion, Replace Destination
File, Link to Destination, Add Version Number to File, and Prompt.  

· The Use Latest Version option will cause zsDuplicateHunter to use the file with the latest timestamp for
the destination file.

· The Cancel Deletion option will cause zsDuplicateHunter to not delete the source file and the destination
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file will not be changed.
· The Replace Destination File option will cause zsDuplicateHunter to replace the destination file with the

source file, delete the source file and create a link from the source to the destination.
· The Link to Destination option will cause zsDuplicateHunter to delete the source file and create a link

from the source to the destination. 
· The Add Version Number to File option will cause zsDuplicateHunter to leave the destination file alone

and create a new file in the destination directory with the text version_X appended to the filename.  So if
you were deleting a file called my_dog.jpg from the source directory and a file named my_dog.jpg already
existed in the destination directory, zsDuplicateHunter would create a new file called my_dog_version_1.
jpg in the destination directory, delete the source file, and create a link to the new file. 

· The Prompt option will cause zsDuplicateHunter to prompt you for the action to take for each changed
file as the file is encountered.

Unmatched File Options
When a file is not matched by any of the rules for creating links, you can have zsDuplicateHunter either delete
the file normally, or preserve the file.  If you select the Delete File option, zsDuplicateHunter will delete the file
according to the rules specified in the File Deletion Options, and it will not create a link.  If you select the
Preserve File option, zsDuplicateHunter will not delete the file.  If you select the Prompt option,
zsDuplicateHunter will prompt you for each file so you can decide whether or not to delete or preserve the file.

4.6.4 Checksum Options

Checksum Options Dialog

Checksum Calculation
zsDuplicateHunter offers two methods of calculating checksums, the Adler32 method and CRC32 method. The
Adler32 method is faster, but slightly less accurate and the CRC32 method is slower, but more accurate. When
checking files within zip files and jars, the CRC32 method is always used. We suggest that in most cases you use
the CRC32 checksum method unless the files you are checking for duplicates are relatively large and you need
the increased speed the Adler32 method gives.

You can also choose whether or not to display the checksum as a hexadecimal number or as a regular decimal
number. This option is a purely personal choice. Feel free to use whichever option is easier for you to read.
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Digest Calculation
This option allows you to control the type of digest you would like to use when finding duplicate files. For more
information, please see the Grouping By Digest section earlier in the help file.

Input Buffer Size
This option allows you to control how much of a file zsDuplicateHunter reads at one time when calculating
checksums and digests, reading files, andcopying files. The ideal setting for this option will depend on the
configuration of your computer. In most cases the default setting of 32KB will be the best setting for you.
However, if your computer is running more slowly than you would like, you can experiment with the various
settings on a small set of files to determine the optimal configuration for your needs.

Controlling the input buffer size is available only in the Professional version.

4.6.5 Timestamp Options
ZsDuplicateHunter allows you to customize the display of the timestamps displayed within the software by
defining the Timestamp Format. When you define a format, zsDuplicateHunter will display a sample format
using the current time so you can ensure that the format is behaving as expected.
You can also control the Current Time zone which will help zsDuplicateHunter to properly format dates
according to your location.

Timestamp Options Dialog

Creating a Timestamp Format
Timestamp formats are specified by date and time pattern strings. Within date and time pattern strings, unquoted
letters from 'A' to 'Z' and from 'a' to 'z' are interpreted as pattern letters representing the components of a date or
time string. Text can be quoted using single quotes (') to avoid interpretation. "''" represents a single quote. All
other characters are not interpreted; they're simply copied into the output string during formatting or matched
against the input string during parsing.
The following pattern letters are defined (all other characters from 'A' to 'Z' and from 'a' to 'z' are reserved):

Letter Date or Time Component Presentation Examples

G  Era designator Text  AD

y  Year Year  1996; 96
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M  Month in year Month  July; Jul; 07

w  Week in year Number  27

W  Week in month Number  2

D  Day in year Number  189

d  Day in month Number  10

F  Day of week in month Number  2

E  Day in week Text  Tuesday; Tue

a  Am/pm marker Text  PM

H  Hour in day (0-23) Number  0

k  Hour in day (1-24) Number  24

K  Hour in am/pm (0-11) Number  0

h  Hour in am/pm (1-12) Number  12

m  Minute in hour Number  30

s  Second in minute Number  55

S  Millisecond Number  978

z  Time zone General time zone  Pacific Standard Time; PST; GMT-08:00

Z  Time zone Relative time zone  -0800

Pattern letters are usually repeated, as their number determines the exact presentation:
· Text: If the number of pattern letters is 4 or more, the full form is used; otherwise a short or abbreviated

form is used if available. 
· Number: If the number of pattern letters is the minimum number of digits, and shorter numbers are zero-

padded to this amount. 
· Year: If the number of pattern letters is 2, the year is truncated to 2 digits; otherwise it is interpreted as a

number.
· Month: If the number of pattern letters is 3 or more, the month is interpreted as text; otherwise, it is

interpreted as a number.
· General time zone: Time zones are interpreted as text if they have names. Otherwise, they are interpreted

as an offset from Greenwich Mean Time.

Examples
The following examples show how date and time patterns are interpreted in the U.S. locale. The given date and
time are 2001-07-04 12:08:56 local time in the U.S. Pacific Time time zone.

Date and Time Pattern Result
 yyyy.MM.dd G 'at' HH:mm:ss z  2001.07.04 AD at 12:08:56 PDT

 EEE, MMM d, ''yy  Wed, Jul 4, '01

 h:mm a  12:08 PM

 hh 'o''clock' a, zzzz  12 o'clock PM, Pacific Daylight Time

 K:mm a, z  0:08 PM, PDT

 yyyyy.MMMMM.dd GGG hh:mm aaa  02001.July.04 AD 12:08 PM

 EEE, d MMM yyyy HH:mm:ss Z  Wed, 4 Jul 2001 12:08:56 -0700

 yyMMddHHmmssZ  010704120856-0700

4.6.6 Scripting Options
The Scripting Options are available only within the Enterprise Edition of zsDuplicateHunter.  The Scripting
Options give you control over the default locations where scripts and results are stored as well as control over
how the filename of the results is generated and what is displayed after the script has run.
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Scripting Options Dialog

The Scripts Folder stores the default path which is used when opening and saving scripts.  The Results Folder
stores the folder to which all results will be written.  

The Results Display Type controls what zsDuplicateHunter displays after a script has been run.  The default
option, Display full report after run will display an HTML report with the results of the script including each
step that was run.  The  Display pass/fail after run option will simply display a message after the script has run
stating whether or not the script has passed or failed.  ZsDuplicateHunter determines if the script has passed or
failed based on the Script Passes variable.  You can optionally display the results from the message informing
you if the script passed or failed.  The Display nothing after run option will not display anything after the script
has finished.  You can check the results by opening the result file for the script which will be in the Results
Folder.

The Include Date in Report Filename option determines whether or not zsDuplicateHunter includes the date in
the name of the results file when it writes the report for the script results.  By including the date, you can track a
history of the script results.  However, including the date will cause a new file to be created with each run of the
program.  Be sure to periodically archive your results to save hard-drive space.

The Log actions during run options allows you to log each action that is run to the zsDuplicateHunter log file
which is located in the directory where you installed zsDuplicateHunter.  This option can be useful to debug a
script if you have created an infinite loop, or if the script does not finish.

The Global Variables section allows you to create variables which are used for all script runs.  With global
variables, you can make your scripts more robust by taking out common information from the script and creating
a global variable for it.  For example, if you are calling a large number of scripts, you could create a global
variable which contains the path of the script and then reference the global variable within your scripts.  Or, if
you are running zsDuplicateHunter on different operating systems, you can define a global variable for the
operating system and then branch within the script depending on the current operating system.  The Add Global
Variable button adds a new row to the Global Variables table.  The Remove Global Variable button removes
the currently selected row or rows.  

4.6.7 Duplicate Hunt Options
ZsDuplicateHunter allows you to control how duplicates are grouped together as well as which files and folders
are searched. All options to control the hunt for duplicates are on the top portion of the right side of the main
screen. Note: some options are available only in the Professional version of zsDuplicateHunter.
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4.6.7.1 General Duplicate Hunt Options

The General Duplicate Hunt Options contain options that apply to all duplicate hunts no matter what other
options are selected.  

Remaining Time Estimation
The Remaining Time Estimation method controls how zsDuplicateHunter estimates the amount of time
remaining in the duplicate hunt.  There are three options.  
1. Calculate Number of Files to Search Before starting duplicate hunt.
2. Calculate Number of Files to Search during duplicate hunt.
3. Do not estimate time remaining.
If you want to see the time remaining then either of the first two methods will display the time remaining in the
duplicate hunt.  The second method will result in a slightly faster total duplicate hunt time, but the first method is
easier to understand as the total number of files to be searched is completely calculated before the program starts
to determine if files are duplicates.

Not estimating the time remaining will result in the fastest duplicate hunt on most systems, but you will not be
able to see the remaining time.

By default, the program calculates the number of files to search before starting the duplicate hunt.  You can only
change this setting in the Standard and Enterprise Editions of zsDuplicateHunter.

Please note, the time remaining is an estimate based on the amount of data to be found.  The remaining time will
normally be close to the total duplicate time remaining, but it can be high or low depending on the actual data
being searched, the number of duplicates found, the number of files being searched, etc.  In general, the
remaining time will stabilize and be more accurate after the duplicate hunt is about 25% complete.

Duplicate Hunt Priority
The Duplicate Hunt priority allows you to control how much of the computer's resources a duplicate hunt can
take.  You can set the priority to High, Medium, and Low.  The higher this setting is, the faster the duplicate hunt
will finish.  However, other programs that you run at the same time will be slower.

By default the priority is set to Medium.  You can only change this setting in the Standard and Enterprise
Editions of zsDuplicateHunter.
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Show Deletion Method Details
The Show Deletion Methods Checkbox will allow you to hide the detailed information about each deletion
method from the main screen.  Hiding the information will allow more results to be shown at one time.

4.6.7.2 Grouping Options

Enter topic text here.
4.6.7.2.1  Grouping by Name

Grouping files by name will cause zsDuplicateHunter to group any files that have identical filenames together.
Grouping by filename alone will NOT ensure that the files are unique. However, it is useful for finding extra
copies of a file. For example, using a name comparison only will allow you to find backup files that have been
created and forgotten, or to find songs that may exist on multiple CDs.
When searching for true duplicates (using checksum or digest grouping), grouping by name can help to make
duplicate files easier to manage.

4.6.7.2.2  Grouping by Size

Grouping files by size will cause zsDuplicateHunter to group any files that have the same size (measured in
bytes). Grouping by size alone will not determine if files are true duplicates. However, grouping by size can help
you to determine which duplicates you should concentrate on. Duplicates that are very large will save the most
space on your hard disk if they are removed. Zero size files can be safely deleted in most cases. These files do
not take up much space, but they can slow down searching for files as well as backups.

4.6.7.2.3  Grouping by Checksum

Grouping by checksum will cause zsDuplicateHunter to group any files that have the same checksum together.
ZsDuplicateHunter can calculate two different types of checksums using the CRC32 algorithm or Adler32
algorithm. The Adler32 algorithm is faster, but less reliable. In both cases, the checksum is a number calculated
from the contents of a file. There is a small chance that two files can have different contents and the same
checksum. However, when you combine grouping by checksum with grouping by Size, the chance of two
duplicates being falsely identified is very small on all but the largest files.

Grouping by Checksum and Size without grouping by name is a good way of identifying exact duplicates that
may have been renamed. For example, when copying a file, most operating systems automatically rename the file
to Copy of (original filename). Grouping by Checksum and Size will identify these files as duplicates even
though the files have different names.

4.6.7.2.4  Grouping by Digest

Digests are essentially more accurate checksums. They are very useful when you want to ensure that there is no
chance of zsDuplicateHunter falsely identifying two files as duplicates. A checksum is a 4 byte number and there
is some chance that two files could be different but have the same checksum (the likelihood is very low though).
Digests range from 128 bits (for MD5 and SHA-1) to 512 bits (for SHA-512). It is theoretically possible
(although extremely unlikely) that collisions could occur for the smaller digests however research indicates that
collisions are not possible on the large digests (SHA-256, SHA-384, and SHA-512).

If it is possible to have collisions using checksums and the smaller digests, why would you want to use them?

Calculating the larger digests takes considerably more time than calculating checksums and the smaller digests.
Also, the chance of getting false positives is very low. Ultimately, the decision of which method to use when
grouping files requires you to balance speed and accuracy concerns to meet your needs. For comparison purposes
here are some timings using various checksum and digest methods for grouping.

Timing Example 1
Timings for a small folder with approximately 3,800 files in it. Most files are quite small.

Grouping Type Time (seconds)

Adler Checksum 14.2

CRC32 Checksum 13.7
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CRC32 and Size 14.0

MD5 Digest 14.8

SHA-1 Digest 15.2

SHA-256 Digest 15.9

SHA-384 Digest 18.2

SHA-512 Digest 18.2

In this case, the times correlate well with the strength of the algorithm (the better algorithms take significantly
longer to check). In all cases, the same number of duplicates were found (no false positives in any of the checks).

Timing Example 2
Timings for a large folder with approximately 59,000 files in it. Files are larger than the first test.

Grouping Type Time (minutes)

Adler Checksum 3.4

CRC32 Checksum 3.7

MD5 Digest 6.1

SHA-1 Digest 6.6

SHA-512 Digest 7.9

Again, the times correlate well with the strength of the algorithm (the better algorithms take significantly longer
to check). In this cases though, the digest algorithms are nearly twice as slow as the checksum algorithms. This
shows that the time to calculate the digests and checksums are related to the size of the files.

4.6.7.2.5  Perform Binary Check

The Perform Binary Check option will perform a binary check of the files before grouping them together.  The
Binary Check is a failsafe mechanism when grouping by checksum or digest to ensure that files with different
contents are not grouped together.  

The Binary Check is optimized to take as little time as possible however, it will cause the duplicate hunt to slow
down because the file will need to be opened and closed additional times to read and compare the contents.

4.6.7.2.6  Grouping by Path

Grouping by path will cause zsDuplicateHunter to group any files that are in the same folder together. Grouping
by path alone will NOT ensure that the files are unique. However, it is useful if you need to ensure that one copy
of a file exists in multiple locations. For example, if you have a directory of the originals of your pictures as well
as a backup directory and you want to scan both the directories at the same time, you could group by Path, Size,
and Checksum. This search would allow you to find any duplicates that are in the originals directory as well as
any duplicates that are in the backup directory, but it would not mark the backups as duplicates.
Grouping by Path is available in the Professional Edition only.

4.6.7.2.7  Grouping by Extension

Grouping by extension will cause zsDuplicateHunter to group any files that have the same extensions together.
Grouping by path alone will NOT ensure that the files are unique.

This option is useful because it separates files according to the type of a file. For example, using this option will
separate jpg files from gif files and png files. This option can also be useful to separate backup files from original
files. For example, some programs will name backup files with bak for the extension or with a tilde and the
original extension. Using this option would ensure that the original file and the backup file were not grouped
together.
Grouping by Extension is available in the Professional Edition only.
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4.6.7.2.8  Grouping by Timestamp

Grouping by timestamp will cause zsDuplicateHunter to group any files that were last modified at exactly the
same time. Grouping by timestamp alone will NOT ensure that the files are unique.

This option is useful because it separates files according to when they were last modified. You could use this to
ensure that any files that were last accessed at different times are not grouped together.

Grouping by Timestamp is available in the Professional Edition only.

4.6.7.2.9  Searching Sub Folders for Duplicates

When you turn Search Sub Folders on, zsDuplicateHunter will search for duplicate files in the folders you have
selected as well as any folders within the selected folders. You will want this on in almost every case. The only
reason to turn it off is if you want very fine-grained control over which folders are compared.

4.6.7.2.10  Searching Zip Files for Duplicates

When you turn Search Zip files on, zsDuplicateHunter will search within any zip files and jar files it encounters.
You will normally want this setting off unless you are specifically looking for files that may exist within zip files.

Searching Zip Files is available in the Professional Edition only.

4.6.7.2.11  Ignoring Hidden and/or System files

Ignoring files based on if they are hidden and/or system files tells zsDuplicateHunter to ignore any files that are
hidden or system files. The system file option is only available on the Windows platform.

In most cases you will want to leave these options on to prevent deletion of files that are important to your
operating system.

4.6.7.2.12  Including Unique Files in Results

This option determines whether or not zsDuplicateHunter includes any files which are unique in the results.
When this option is turned off, the amount of memory needed by zsDuplicateHunter will be significantly
reduced. However, you will not be able to view any files which are unique. Leaving this option off also reduces
the likelihood of a unique file being accidentally deleted.

In general, we suggest that you leave this setting turned off.

4.6.7.3 Duplicate Hunt Filters

ZsDuplicateHunter offers several options for filtering files and folders. Using the filtering options gives you
control over exactly which files are searched and can speed up the duplicate hunt (because fewer files need to be
grouped). Filters are set on the Duplicate Hunter tab in the options dialog. Note: some filters are available only in
the Professional version of zsDuplicateHunter.
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Filtering by Filename
ZsDuplicateHunter allows you to filter files and/or folders based on pattern matches. Unless you use regular
expression matching the rules used to determine if a file or folder passes a filter are:
· a * matches any sequence of characters
· a ? matches any single character
If you use regular expressions, the filter will use regular expressions to determine if the file passes the filter. For
more information on regular expressions, see the understanding regular expressions section. Filtering using
Regular Expressions is only available in the Professional version.

To further refine the filter, you can set to either include or exclude matches. The "include" setting is useful if you
have a small set of files you want to search without worrying about the remainder of the files. You can also set it
to filter either by name or by path. Filtering by full path requires you to enter the full path of the files or folders
you would like filtered. Filtering by name will only match the display name of the file or folder including the
extension if any.

Examples
For example, if you are searching for duplicate music files, you may want to include only files with extensions of
mp3 using a filter specified as *.mp3. The comparison would then ignore any files that are not mp3 files.

On the other hand if you have already checked your music and wanted to exclude it, you could set an exclude
filter for *.mp3;*.wma. The comparison would then ignore only files with the extensions of mp3 and wma, and
would compare other documents types.

Ignoring Files based on File Size
ZsDuplicateHunter allows you to filter files based on the size of the file. To filter by size, first select the criteria
you would like zsDuplicateHunter to apply when doing filtering (less than, between, greater than, etc.). Then
select the size to filter based on. When setting the size you can specify the size in bytes, kilobytes (KB),
megabytes (MB), or gigabytes (GB).

Filtering by size can be very useful if you want to exclude large files which require a long time to calculate their
checksums, or if you only want to only search large files that take up a large amount of space. You can also use
filtering by size to find all of the empty files on your computer. Just set the filter to include files less than or
equal to 0 bytes.
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Ignoring Files based on File Time
ZsDuplicateHunter allows you to filter files based on the time the file was last modified. To filter by time, first
select the criteria you would like zsDuplicateHunter to apply when doing filtering (earlier than, between, later
than, etc.). Then select the time to filter based on. 

Filtering by time can be very useful if you want to remove duplicate files that have not been used for a set time
period, or if you have already removed the majority of your duplicates and only want to look for duplicates in
files that have been modified recently.

Ignoring Files based on Attributes
ZsDuplicateHunter also allows you to filter files based on some attributes of the files. You can ignore hidden
files on all operating systems. On the Windows operating systems you can also ignore system files and shortcuts.
On Mac OS X you can also ignore aliases. Ignoring shortcuts and aliases is only available in the Professional
Version.

In most cases you will want to leave these options on to prevent deletion of files that are important to your
operating system.

4.7 Warning Dialog
The Warning Dialog is used to display information about files which will be deleted, or which could not be
deleted. The list of files can be copied to the clipboard or saved to file for future reference.

4.8 Splash Screen

Splash Screen

The Splash or startup screen appears when you first start the program.  If you have not yet purchased
zsDuplicateHunter, the screen will appear as above and you will need to make a selection to continue.  If you
have already purchased zsDuplicateHunter, the splash screen will show as the program is loading and it will then
been dismissed automatically. 
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From the splash screen, you can select the Order online button which will direct you to the Zizasoft Website
where you can purchase a registration key for zsDuplicateHunter.

The Launch button will dismiss the splash screen, and open the main screen of zsDuplicateHunter.

The Enter Key button allows you to enter your registration key after you have purchased zsDuplicateHunter.

The Quit button will close zsDuplicateHunter.

4.9 Entering a Registration Key

Enter Registration Key Dialog

After you have purchased a copy of zsDuplicateHunter, you will need to enter your registration key.  You can
access the Enter Registration Key dialog from the Splash Screen, the About Screen , or by selecting the Enter
Registration Key menu item from the Help menu.

When you enter your registration key, make sure that you are entering the registration key in the correct program,
a registration key for the Standard Edition will not work in the Professional Edition and vice versa.  Also, make
sure that the case of the Name/Serial Number matches the case in your receipt.

If you have any problems entering your registration key, please contact us at support@zizasoft.com.  If you ever
lose your registration key, we would be happy to send it to you again.  To have your registration key resent to
you, please e-mail support@zizasoft.com.  Please include as much information about the order as you can
including:
· the program that you purchased
· your full name
· company name if appropriate
· order number
· e-mail address where the order was originally sent
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4.10 Checking for Updates
When you purchase zsDuplicateHunter from Zizasoft, we allow you to download many updates to
zsDuplicateHunter for free.  To ensure that you are always working with the latest version, our products offer
you the ability to check for updates from within the program either manually or automatically.

Check For Updates Dialog

Manually checking for updates
To manually check for updates from within a program, select the Check for Updates menu item within the Help
Menu. You will then need to select the Check Now button.

This command contacts the Zizasoft server to determine if any updates are available for your program. If there
are updates, information about the new features will be displayed with information on how to download the new
version.

Automatically checking for updates
To schedule a program to check for updates automatically, select the Check for Updates menu item within the
Help Menu and set the Frequency to anything other than Never. We try release new versions of our products
three to four times each year. Therefore, we suggest that you set the update check to once a week or once a
month.  zsDuplicateHunter will now automatically check for available updates each time you start the program
(unless you are running zsDuplicateHunter using the command line interface).

Note: Checking for updates does not send any personally identifiable information to Zizasoft.
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4.11 About Dialog

About Dialog

The about dialog includes information about whether or not the program is currently registered or not, who the
program is registered to, contact information for Zizasoft, and basic system information.

From the about dialog, you can also access the zsDuplicateHunter License within this help file, go to the Zizasoft
website, view  diagnostics, and access the Memory Monitor.

The Diagnostics button will take you to the Diagnostics dialog which contains basic information about the setup
of your computer which may be helpful when diagnosing any problems with zsDuplicateHunter.  If you
encounter an error in zsDuplicateHunter, we may ask you to send us the information from the diagnostics dialog.
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4.12 Tip of the Day

Tip of the Day Dialog

The Tip of the Day dialog automatically appears when zsDuplicateHunter starts if you have the Show tips at
startup checkbox selected.  If you prefer to not see the Tip of the Day, simply uncheck the Show tips at startup
checkbox.  You can also access the Tip of the Day dialog by selecting the Tips menu item in the Help menu.

The tips give valuable advice about ways to make your usage of zsDuplicateHunter faster and more productive.

4.13 Memory Monitor
The memory monitor can be opened using the Memory Monitor menu item in the Help menu. The memory
monitor gives an indication of how much memory zsDuplicateHunter is currently using.  a trend of graph of
memory usage of time is shown as well as the peak usage of memory and how much is being currently used.
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Memory Monitor Dialog

Memory Graph
The Memory Graph shows the amount of memory which zsDuplicateHunter is currently using.  As well as how
much memory has been used in the past.

The Reclaim Memory button is used to tell zsDuplicateHunter to reclaim any memory which it is holding that is
not immediately required.  ZsDuplicateHunter will do this automatically at timed intervals, but it can be useful to
force it to reclaim memory occasionally.

In general, the memory monitor will not be of much interest to you.  However, if you are encountering a problem
running a comparison or synchronization, we may ask you to open the memory monitor while the comparison is
running. 

Object Allocations
The Object Allocations tab on the memory monitor dialog shows the number of objects which have been created
and destroyed while the program is running.  Again this will not generally be of interest to you unless you are
encounter a problem which we need your help resolving.
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Object Allocations Screen

The allocation table does not automatically refresh.  You can refresh it manually by selecting the Refresh
Allocations button.  You can also change how the results are sorted using any of the sort options.  The Show
Only active objects checkbox will cause zsDuplicateHunter to only display objects which have active instances.

4.14 Adjusting the Available Memory
ZsDuplicateHunter allows you to adjust the maximum amount of memory which the program will use.  To adjust
the amount of memory available to zsDuplicateHunter, select the Adjust Available Memory menu item from the
help menu.  The program will then display the maximum memory which will be used and it will allow you to set
a new value.  When selecting a new value, please take care not to set a value more than the amount of memory
available on your system as the program may not function correctly.

Any changes will take effect when you restart your computer.
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Adjust Available Memory Dialog

If you receive an out of memory error while running zsDuplicateHunter, you can try increasing the amount of
memory available to see if that corrects the problem.
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5 Command Line Options

ZsDuplicateHunter can be used from the command line which allows you to automate zsDuplicateHunter to
perform tasks.   The command line interface works best on Windows Operating Systems.  The Command line
interface is only available in the Enterprise Edition of zsDuplicateHunter. 

The easiest way to automate zsDuplicateHunter using the command line is to create a batch file with the
command line you would like to run. If you would like to run multiple commands, add them to the batch file with
each command on its own line.

When creating a batch file, be sure to set the current working directory to the directory where zsDuplicateHunter
is installed before starting zsDuplicateHunter.  If you do not set the current working directory appropriately,
zsDuplicateHunter may not start correctly.  You can set the working directory in a Windows batch file using the
command cd and the path to the folder.  For example,
cd "c:\Program Files\Zizasoft\zsDuplicateHunterEnt\" 
Will set the current directory to the default location where zsDuplicateHunter Enterprise Edition is installed.

Also, depending on how you are calling zsDuplicateHunter, you may need to put quotes around any paths or
arguments which include spaces to ensure that Windows interprets them correctly. You may also need to specify
the full path to zsDuplicateHunter if your current working directory is not the directory where zsDuplicateHunter
is installed.

If you would like to run zsDuplicateHunter automatically on a schedule, we suggest you use the Windows Task
Scheduler.

If you want to automate zsDuplicateHunter on a system other than Windows or if you have more advanced needs
than the command line supports, we suggest that you use the scripting functionality available within the
Enterprise Edition of zsDuplicateHunter.

If you need any help with your automation efforts, please do not hesitate to contact us at support@zizasoft.com.
Please include a detailed description of what you are trying to accomplish with your automation efforts.

5.1 /script command
The /script:<file> command line option allows you to run the specified script.  The script must already exist and
it must have been created from within zsDuplicateHunter.  ZsDuplicateHunter will also automatically recognize
any scripts that you have created when you double click on them (assuming that you did not disable setting file
extensions during the installation).  

This command can be used when you want to do more advanced tasks with zsDuplicateHunter than the provided
command line options allow but you still want to run zsDuplicateHunter from the command line.

The /script command can only be used in the Enterprise Edition of zsDuplicateHunter.  

To automatically show the results after the script finishes, specify the /showResults option.

Usage Example
zsDuplicateHunter /script:"c:\zsDuplicateHunter\advanced tasks.zsDHScr" /close
This example runs the script c:\zsDuplicateHunter\advanced tasks.zsDHScr after loading zsDuplicateHunter.
The actions the script performs depend on the actual script being loaded.  When the script finishes running, 
zsDuplicateHunter will be closed automatically.

5.2 /close command
The /close command causes zsDuplicateHunter to automatically close after performing any comparison and
synchronization actions specified on the command line.  This is typically used when automating 
zsDuplicateHunter from the command line and it is not desirable to have zsDuplicateHunter remain open.
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Usage Example
zsDuplicateHunter "/script:c:\scripts\automated removal.zsDHScr" /close
This example loads the script c:\scripts\automated removal.zsDHScr, runs the script, and then closes
zsDuplicateHunter.

5.3 /noSplash command
The /noSplash command causes zsDuplicateHunter to not display the splash screen while the actions specified on
the command line are performed.  This is typically used when automating zsDuplicateHunter from the command
line and it is not desirable to show the zsDuplicateHunter splash screen.  You may abbreviate the /noSplash
command line option /ns.

Usage Example
zsDuplicateHunter /session:c:\sessions\frequent comparison.zsDH /noSplash

5.4 /clearPrefs command
The /clearPrefs command will restore zsDuplicateHunter to the settings which were shipped in the initial
installation of zsDuplicateHunter by removing any user defined information.  You can abbreviate the /clearPrefs
command /cp.

Usage Example
zsDuplicateHunter /clearPrefs /close
This example clears all of the user defined settings for zsDuplicateHunter and then closes zsDuplicateHunter.
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6 Scripting zsDuplicateHunter

The Enterprise edition of zsDuplicateHunter allows you to create scripts to automate zsDuplicateHunter.  These
scripts provide access to functionality which is not available from the command line.  Scripting also makes it
easier to automate zsDuplicateHunter when using zsDuplicateHunter on Linux and Mac OS X.  

The majority of the functionality found in zsDuplicateHunter is available using the Script actions of
zsDuplicateHunter.  However, there is some functionality which is not available.  The functionality which is not
available is generally not required in typical automation tasks.  For example, you cannot launch the Help system
using Script actions.  However, this is not an action that is typically needed during automation.  If you require an
action that is not available, please let us know so we can add it to future releases of zsDuplicateHunter or help
you to find an alternative method of achieving the same end result.

6.1 Creating and Editing Scripts
When you are ready to create a script, or edit an existing script, select the Create and Edit Scripts menu item
from the Scripts menu.  This will open the Script Editor Dialog as shown below.  

Script Editor Dialog - New Script

Script Details
The Script Details section will show the script as it is currently written.  The first line contains the name of the
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script.  If the script has not been saved, the name will be Untitled.  Each action will be on it's own line below the
name of the script as shown below.  The step number of the action will be before the name of the action. The
parameters of each action will be shown after the action name in parenthesis.  When an action is indented under
the action above it, the indentation indicates that the indented action will be run only if the action above it fails. 
For an example, see the End Script action which is indented below the Check Property action.  You can select
any row to view information about the action in the Selected Action Details.

Script Editor Dialog with a Script Defined

Selected Action Details
The Selected Action Details section, gives you the ability to review the 

Action Target
The Action Target tells you which screen is currently active.  You can use the active target information to look
up information about the available actions in this help manual.  Each target is described in the Available Script
Actions section of the manual.

Action to Perform
The Action to Perform is a drop down list which lists all of the available actions you can use on the specified
target.  You can change between the available actions to select the action appropriate for your needs.  The
functionality of each action is described in the Available Script Actions section of the manual.
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Handle action failure with separate action
This setting allows you to control whether or not you want to branch your script if a failure occurs during the
action.  Actions can fail for specific reasons.  For example, if you use an action to select a row and that row does
not exist, the action will fail.  Using a failure action gives you a chance to recover from the failure.  If you choose
not to handle failures with a separate action, the script will simply continue to run.  Please be aware that not
handling the failure may lead to additional failures.

Parameters
The parameters table lists the parameters which need to be filled out for the action to run.  In many cases, the
valid values for a parameter will be provided for you and when you select the parameter, zsDuplicateHunter will
display a drop-down list of the valid values which you can select from.  If the valid values are not provided, you
can simply type them in.  When specifying parameter values, you can specify a variable by surrounding the
variable name with curly braces.  For example, specifying {current row} will use the value of the current row
variable if it has been defined.  Variable names are not case sensitive when used to fill out parameter values.

Insert Action Before
The Insert Action Before button will insert an action before the currently selected action.  The action inserted
will be a Pause action.  

Insert Action After
The Insert Action After button will insert an action after the currently selected action.  The action inserted will be
a Pause action.  

Delete Action
The Delete Action button will delete the currently selected action.  You cannot delete the last action in a script or
branch of a script, and you cannot delete an action which is a transition between dialogs or areas within dialogs.

Update Action
The Update Action button will save any information you have made to the current action and it will leave the
selected action set as it was.

Update Action and Move to Next
The Update Action and Move to Next button will save any information you have made to the current action and
it will move the currently selected action to the next action in the list.  This is the most efficient way to create
scripts.

New Script
You can create a new script which clears the script which is currently loaded by selecting the New Script button.

Saving and Loading Scripts
You can save and reload scripts using the Save Script, Save Script As and Load Script buttons.  When you
save a script, you will be prompted for the name of the file to save to.  This name will also be used as the name
of the script in the Script Editor.  Be sure to update any changes you have made to the current script before
saving.  If you use the Save Script As button you will always be prompted for the name of the file.  With the
Save Script button, you will only be prompted if the script has never been saved before.  When you load a script,
you will be prompted for the file to load.  The file will be read by zsDuplicateHunter and loaded into the user
interface replacing any information that was in the editor previously.  You can control the default location for the
scripts in the Script Options section of the Options Dialog.

Running the Script
To run a script, simply select the Run Script button.  This will temporarily hide the Script Editor and start the
script.  After the script is complete, the results of the script will be shown.  You can control the location where
the results are written as well as how the results are displayed in the Script Options section of the Options Dialog.
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6.2 Running a Script
You can run a script using four different methods:
1. You can use the script editor to run either a temporary script or a saved script.  To access the script editor,

select Create and Edit Scripts from the Scripting menu.
2. You can run a saved script using the Run Script item from the Scripting menu.  After you select the Run

Script menu item, you will be prompted for a script file to run.  After selecting the script file, the script will
run and when it is finished, you will be presented with the results.

3. You can run a saved script using the /script command line menu.  When after the script is complete, the results
will not be displayed by default.  

4. If you have associated the zsDHScr extension with zsDuplicateHunter, you can double click on the saved
script file, and zsDuplicateHunter will automatically launch and run the script.  When after the script is
complete, the results will not be displayed by default.

When zsDuplicateHunter runs a script, it will save the results of the script as an HTML file.  The results are
saved in a subdirectory under the directory where you script is located called results.  The file will be titled:   

script name-results-run time.html
Where script name is the name of the script that was run and run time is the time that the script finished running.
The run time will be formatted as yyyy-MM-dd-HH-mm which will allow for easy sorting of the results in your
file system.  You can prevent zsDuplicateHunter from adding the run time in the Options.

If you have chosen to display the results in the Scripting Options section of the Options dialog, the results will be
displayed in your browser and you will be able to print the results from there.  If you have selected the Display
pass/fail after run option, the program will allow you to display the results from the message informing you if the
script passed or failed.

6.3 Predefined Variables
When you run scripts, you can create and edit variables.  You can also define global variables which apply to all
scripts within the Options Dialog. 

In addition to the variables you define yourself, zsDuplicateHunter contains a limited number of pre-defined
variables which make scripting easier.

Variable Name Description

Current Time Contains the current time formatted according to the Timestamp Format on the 
Timestamps tab within the Options dialog.

6.4 Available Script Actions
This section describes the actions which are available within zsDuplicateHunter.  It also discusses the allowable
parameters for each action.

6.4.1 Basic Actions
There are several actions you can use which are available on all dialogs.  These actions are described here.

Check Available Script Actions
This action allows you to check which actions are available on the current object which is being scripted.  The
list of available actions will be separated with semi-colons.  The list does not include Basic Actions which are
included for all objects.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, ends with,
and no check.  

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the value to
be.
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Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, ends with,
and no check.  

Variable To Set Optionally specifies a variable to set.  If the Variable To Set is not provided, it will be
ignored.  If the Variable To Set cannot be found, it will be created.

Check If Variable Is Defined
The Check If Variable Is Defined action allows you to check if a variable has been created already. You can
use this action to prevent redefining variables that have been defined earlier or that have been defined by a parent
script.

Parameter Name Description

Variable Name Specifies the name of the variable which will be created. 

Expected Result Specifies if the variable is expected to be defined or not.  Valid values are true and
false.

Check Clipboard Contents
The Check Clipboard Contents action allows you to check the information which is currently on the system
clipboard.  

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, ends with,
and no check.  

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the value to
be.

Variable To Set Optionally specifies a variable to set.  If the Variable To Set is not provided, it will be
ignored.  If the Variable To Set cannot be found, it will be created.

Check Current Object Name
This action allows you to check the name of the object which is currently active within the script.  

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, ends with,
and no check.    

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the value to
be.

Variable To Set Optionally specifies a variable to set.  If the Variable To Set is not provided, it will be
ignored.  If the Variable To Set cannot be found, it will be created.

Check File Information
The Check File Information action allows you to find information about the files and folders on your system. 
You can use this to ensure that information has been written correctly, or to evaluate files which will be
compared.

Parameter Name Description

File to Check The full path to the file you wish to check.
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Parameter Name Description

Property to Check Specifies which property of the file should be checked.  Valid values are: 
Attributes - Returns the attributes of the file.
Checksum-Adler32, Checksum-CRC32 - Returns the checksum as a hexadecimal
number
Creation Date - Returns the time when the file was last modified formatted according
to the formatting which is set in the options.
Digest-MD5, Digest-SHA-1, Digest-SHA-256, Digest-SHA-384, Digest-SHA-512 - 
Returns the digest as a hexadecimal number
Exists - Returns whether or not the file exists, valid values are true and false.
Is Alias - Returns whether or not the file is an alias or shortcut.  Valid values are true
and false.
Is Directory - Returns whether or not zsDuplicateHunter will treat the file as a
directory.  Note, Zip Files as files even though they can be opened as directories
depending on the comparison options.  Valid values are true and false.
Is Empty - Returns whether or not the directory is empty.  If the setting Treat Folders
With Hidden Files Only As Empty (In the File Deletion Options) has been turned on,
this property will include that criteria in the check.  Valid values are true and false.
Is File - Returns whether or not zsDuplicateHunter will treat the file as a file.  Note, Zip
Files as files even though they can be opened as directories depending on the
comparison options.  Valid values are true and false.
Is Hidden File - Returns whether or not the file is a hidden file.  Valid values are true
and false.
Is Removable Media - Returns whether or not the file is on removable media like a CD
or Floppy disk.  Valid values are true and false.
Is System File - Returns whether or not the file is a system file.  Valid values are true
and false.
Last Modified Time - Returns the time when the file was last modified formatted
according to the formatting which is set in the options.
Number of Children - Returns the number of files and folders which are contained
within the directory.  
Size - Returns the size of the file in bytes.
Type - Returns the type of the file.  Valid values are File, Folder, Zip File, Zip File
Entry, Snapshot, Snapshot Entry

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, and ends
with.  

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the value to
be.

Check Variable
The Check Variable action allows you to check the contents of a variable.  In most cases, you will want to
handle the failure of the check using a separate action.  The available variables will depend upon the variables
that have been defined.  The action will fail if the comparison does not work, or if the Variable cannot be found. 
You can create variables using the Create Variable action.

Parameter Name Description

Variable The Variable parameter determines which variable you want to check.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, and ends
with.  
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Parameter Name Description

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the variable
to hold.

Comment
The Comment action allows you to add a comment to the script.  The comment is echoed to the results file, but
does not otherwise effect the script.

Parameter Name Description

Comment The comment which will be displayed in the script and the results.

Compare Files
The Compare Files action does a binary comparison of the two specified files to ensure that they are exactly the
same.  This can be very useful to ensure that results files, are the same as expected.  

Parameter Name Description

Expected File Specifies the full path to the file which contains the expected result.  This is typically
created while the script is being created and it is checked manually to ensure the file has
the correct information in it.

Actual File Specifies the full path to the file which contains the actual result.  This is typically
created during the script run.

Continue
The Continue action will continue execution from the previous location.  This action should always be the last
action within a Loop.  It can also be used in the Failure branch of an action to return to the previous line of
execution.

Copy Files and Folders
The Copy Files and Folders action allows you to copy files and folders from outside of zsDuplicateHunter.
This can be used to copy information which your script relies on.  If a folder is specified, the contents of the
folder will be copied as well.  The action will fail if the file cannot be copied for any reason.

Parameter Name Description

Source File or Folder Specifies the full path to the file which will be copied.  

Destination File or
Folder

Specifies the full path to the file which the source file or folder should be copied to.

Create Variable
The Create Variable action allows you to create a variable which can be used to store information about the
comparisons you are running, or to store a commonly used value. For example, you can store the path to files you
are testing in variable and use the variable instead of the entire path.  If the Variable Name has already been
created, the variable will be updated with the Initial Value and Is String properties.  Variable Names are not case
sensitive.

Parameter Name Description

Variable Name Specifies the name of the variable which will be created. 

Initial Value Specifies the value that the variable should be set to by default.
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Parameter Name Description

Is String Specifies whether or not the variable should be treated as a string for comparison
purposes.  Valid values are yes and no.  If the value is no, the comparison will be done
as a number.

Delete Files and Folders
The Delete Files and Folders action allows you to delete files and folders from outside of zsDuplicateHunter.
This can be used to clean up files and folders which your script relies on.  If a folder is specified, the contents of
the folder will be deleted as well.  The action will fail if the file cannot be deleted for any reason.

Parameter Name Description

File or Folder to
Delete

Specifies the full path to the file or folder which will be deleted.  

End Script
The End Script action terminates the currently running script.  The End Script action will always be the last
action in any script.

Go To Step
The Go To Step action allows you to jump to a different section of the script.  This can be used to emulate
programming concepts like If Then Else statements, or to exit loops prematurely.  The action will fail if the
specified step number cannot be found.  If the action fails, the script will terminate as if End Script were called. 
When using the Go To action, please be careful not to setup infinite loops which your script cannot return from.

Parameter Name Description

Step Number Specifies the step which should be executed next.  

Loop
The Loop action allows you to loop through a sequence of actions zero or more times.  This can be used to work
through the results applying tests and taking appropriate action on each item in the results.  The loop requires
variables to use for iteration.  In most programming languages, this Loop would be represented by a for loop. 
Other types of loops can be emulated with Go To Step commands.  You can also exit the loop using the Go To
Step command.

Parameter Name Description

Loop Variable Name Specifies the name of the variable which will be used to control the start and end of the
loop.  This variable can be referenced from within the loop.  When selecting the Loop
Variable Name, take care not to override a loop variable which already exists if you are
nesting loops.

Starting Value Specifies the starting value of the loop.  By default the starting value is zero.  The
starting value can be any number or it can be a variable. 

End Loop Operation Specifies the operation that should be used to determine if the Loop should be ended. 
The available comparison types are: less than, less than or equal, equal to, greater than
or equal, greater than, not equal, and equal ignore case.  

Ending Value Specifies the value at which the loop should end.

Increment Operation Specifies what should be done to the variable each time a pass through the loop has
been completed.  The valid values are Set, Add,  Subtract, Multiply, and Divide.
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Parameter Name Description

Increment Value Depending on increment operation, specifies the value to increment the starting value
by each time a pass through the loop has been completed.  

Pause
The Pause action will pause execution of the current script for a specified number of milliseconds.  One
millisecond is 1/1000 of a second.  So to pause for one second, you would want to specify 1000.

Parameter Name Description

Milliseconds to Pause Specifies the number of milliseconds to pause the script.  

Set Script Failure
The Set Script Failure action causes a failure to be reported for the script within the report.  This is a shortcut
for setting the predefined variable Script Passes to false.  This variable is reported in the report so you can tell at
a glance if your script executed as expected.

Set Variable
The Set Variable action allows you to update the value of a variable.  Depending on the action selected, you can
set the variable to the value of a property or another variable, increment the variable, or decrement the variable. 

If the Operation is Set, you can set the variable to another variable by enclosing the value in curly brackets {}.
You can also use a combination of a parameter and plain text.  For example, the Value {sample directory}
\Sample Directory can be used to specify a path.  The variable {sample directory} will be expanded when
the variable is set.  All other values will be used as is.  

If the Operation is Add and the variable is a string, the value will be appended to the current value.

The Operations Subtract, Multiply, and Divide will cause an error if they are used with String variables.  The
Divide operation will also cause an error if the specified Value is 0.

Parameter Name Description

Variable Name Specifies which variable should be changed

Operation Specifies what should be done while setting the variable.  The valid values are Set, Add,
 Subtract, Multiply, and Divide.

Value Depending on operation, specifies the value to set the variable to.  

6.4.2 Basic User Interface Actions
These actions will occur on several dialogs.  The dialogs which they appear on will depend on the design of the
dialog and the controls which are available on the dialog.  Each action will be explained further on the dialog
where it occurs.

Change Focus
The Change Focus Action will change focus between sections of a dialog.  For example, on the main screen of
zsDuplicateHunter, there are three tabs, the Directories tab, Files tab, and Freeform Text tab.  You can use the
Change Focus Action to switch between each tab.  In some cases, you will see the special section of previous
which will allow you to move to the last section used.  For example, after you set the focus to the Directory
comparison tab, you will need to call Change Focus with Set Focus to set to Previous in order to return to the
zsDuplicateHunter Main Window.  The available sections which you can transfer focus to will be defined in the
section of the help manual defining the screen.
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Parameter Name Description

Set Focus To The Set Focus To parameter allows you to determine what section to transfer focus to. 
The list of available sections will be pre-filled for you.   You cannot use variables when
specifying this parameter.

Check Action Enabled
The Check Action Enabled action will check if a specified menu item or button is currently enabled.  

Parameter Name Description

Control Specifies the name of the control to check.  The list of valid controls will be provided
and will depend on the screen which is active.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: equal to, not equal, and no check.  The no
check operation is useful when you just want to set a variable.

Expected Value Valid values are true and false.

Variable To Set Optionally specifies a variable to set.  If the Variable To Set is not provided, it will be
ignored.  If the Variable To Set cannot be found, it will be created.

Check List Row
The Check List Row action allows you to check the contents of a specific row in a list box.  The action will fail
if the specified row is not valid or if the actual value does not match the expected value.

Parameter Name Description

List Specifies the list which should be checked.  The list of valid lists will be provided and
will depend on the screen which is active.

Row Specifies the Row which should be checked

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, start with, ends with,
and no check.  The no check operation is useful when you just want to set a variable.

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the property
to hold.

Variable To Set Optionally specifies a variable to set with the value of the table cell.  If the Variable To
Set is not provided, it will be ignored.  If the Variable To Set cannot be found, it will be
noted, but the action will not fail.

Check Property
The Check Property action will appear on most but not all screens.  This action allows you to check the value of
something on the specified target.  For example, on the Directory Comparison Tab, you can check to see if a
comparison is still loading or determine what the currently selected file is.  In most cases, you will want to handle
the failure of the check using a separate action.  The available properties for each screen will be defined in the
section of the help manual defining the screen with the type of expected values you can expect.

When checking the paths of a file, the path separators will be automatically corrected.  This will assist you in
creating cross platform scripts because you will not need to create a separate script due to changes in the file
separator between Windows, OS X, and Linux.
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Parameter Name Description

Property The Property parameter determines which property you want to check.  The list of
available properties will be pre-filled for you to select from.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, ends with,
and no check.  The no check operation is useful when you just want to set a variable.

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the property
to hold.

Variable To Set Optionally specifies a variable to set with the value of the table cell.  If the Variable To
Set is not provided, it will be ignored.  If the Variable To Set cannot be found, it will be
noted, but the action will not fail.

Check Table Column Width
This action allows you to check the width of a column within a table.  The action will fail if the column specified
is not valid or if the actual value does not match the expected value.

Parameter Name Description

Table Specifies the table which should be checked.  The list of valid tables will be provided
and will depend on the screen which is active.

Column Specifies the Column which should be checked.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, and no check.  The no check operation is
useful when you just want to set a variable.

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the property
to hold.

Variable To Set Optionally specifies a variable to set with the value of the table cell.  If the Variable To
Set is not provided, it will be ignored.  If the Variable To Set cannot be found, it will be
noted, but the action will not fail.

Check Table Value
The Check Table Value action allows you to check the value of a cell within a table.  The action will fail if the
row and column are not valid or if the actual value does not match the expected value.

Parameter Name Description

Table Specifies the table which should be checked.  The list of valid tables will be provided
and will depend on the screen which is active.

Row Specifies the Row which should be checked.

Column Specifies the Column which should be checked.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, starts with, ends with,
and no check.  The no check operation is useful when you just want to set a variable.

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the property
to hold.

Variable To Set Optionally specifies a variable to set with the value of the table cell.  If the Variable To
Set is not provided, it will be ignored.  If the Variable To Set cannot be found, it will be
noted, but the action will not fail.
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Check Tree Node Expanded
The Check Tree Node Expanded action allows you to check whether or not the specified row of a tree is
currently expanded.  The action will fail if the specified row is not valid, or if the actual value does not match the
expected value.

Parameter Name Description

Tree Specifies the tree which should be checked.  The list of valid trees will be provided and
will depend on the screen which is active.

Row Specifies the Row which should be checked.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: equal to, not equal, and no check.  The no
check operation is useful when you just want to set a variable.

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the property
to hold.  Valid values are true and false.

Variable To Set Optionally specifies a variable to set with the value of the table cell.  If the Variable To
Set is not provided, it will be ignored.  If the Variable To Set cannot be found, it will be
noted, but the action will not fail.

Check Tree Node Value
The Check Tree Node Value action allows you to check the value of a row in a tree.  The action will fail if the
specified row is not valid, or if the actual value does not match the expected value.

Parameter Name Description

Tree Specifies the tree which should be checked.  The list of valid trees will be provided and
will depend on the screen which is active.

Row Specifies the Row which should be checked.

Operation The operation determines how you want to compare the expected value to the actual
value.  The available comparison types are: less than, less than or equal, equal to,
greater than or equal, greater than, not equal, equal ignore case, and no check.  The no
check operation is useful when you just want to set a variable.

Expected Value The expected value tells zsDuplicateHunter what value you are expecting the property
to hold.  Valid values are true and false.

Variable To Set Optionally specifies a variable to set with the value of the table cell.  If the Variable To
Set is not provided, it will be ignored.  If the Variable To Set cannot be found, it will be
noted, but the action will not fail.

Close Dialog
The Close Dialog action will cause the script to close the active dialog and return to the previous screen.  If the
dialog to be closed has OK and Cancel buttons, there will be a parameter asking if you would like to close the
dialog with the OK button or the Cancel button.  If the dialog only contains a Close button, the parameter will
not be shown.

Parameter Name Description

Close Using Specifies whether the dialog should be closed using the OK button or the Cancel button.
 This parameter will not be visible if the Dialog contains a Close button instead of OK
and Cancel buttons.  Valid values are OK and Cancel.
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Enter Text
The Enter Text action will enter text into a text area. The name of the text area will be added after the action
name.

Parameter Name Description

New Text Specifies the new value for the text area.  

Expand Escape
Characters 

Determines whether or not escape sequences should be converted.  To enter a carriage
return specify \r in the text.  To enter a line feed, specify \n in the text.  To enter a tab,
specify \t in the text.

Expand Tree Node
The Expand Tree Node action will expand or collapse the specified row.  The action will fail if the specified
row is not valid.

Parameter Name Description

Tree Specifies the tree which should be checked.  The list of valid trees will be provided and
will depend on the screen which is active.

Row Specifies the Row which should be checked.  You can also specify current to expand or
collapse the currently selected row.

Action Specifies whether the row should be expanded or collapsed.  Valid values are expand
and collapse.

Move Dialog
The Move Dialog action will move the current dialog dialog from the current location on the screen to the
specified location.  The Move Dialog action will be available whenever the current target is a dialog.

Parameter Name Description

X Position The X Position specifies the horizontal location of the upper left corner of the dialog.  0
is the left side of the screen.  The X Position should be an integer greater than or equal
to 0.  It is specified in Pixels.

Y Position The Y Position specifies the vertical location of the upper left corner of the dialog.  0 is
the top of the screen.  The Y Position should be an integer greater than or equal to 0.  It
is specified in Pixels.

Resize Dialog
The Resize Dialog action will resize the current dialog to the new specified size.  This action will fail if the
current dialog is not resizeable.

Parameter Name Description

Width The Width specifies the horizontal size of the dialog.  The Width should be an integer
greater than  0. It is specified in Pixels.

Height The Height specifies the vertical size of the dialog.  The Height should be an integer
greater than or equal to 0.  It is specified in Pixels.

Select List Row
The Select List Row action allows you to select one or more entries within the specified list box.  The action
will fail if the specified row is not within the applicable range of the list. 
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Parameter Name Description

List Specifies the name of the list which should be used for selection.  The list of available
lists will be provided.

Start Row Specifies the first row which should be selected.  The first row in the list is row 0.

End Row Specifies the last row which should be selected.  The first row in the list is row 0.  To
select only one row, the End Row should be set to the same value as the Start Row.

Add to Current
Selection

Determines whether or not the current selection should be cleared before selecting the
new row or rows.  Valid values are yes and no.

Select Tab
The Select Tab action allows you to change the currently selected tab on the specified tab control.  

Parameter Name Description

Tab to Set Specifies which tab should be changed.  The list of available tab controls will be
provided.

New Tab Specifies whether the name of the tab to which you would like to change.  The tab to
switch to may be specified either by name or by index.  The first tab in a set is index 0. 
Tab names are case-sensitive.

Select Table Cell
The Select Table Cell action will allow you to select a specified cell within a table.  The action will fail if the
specified row or column is not within the range of available rows and columns.  If you select a cell which is
already selected, the cell will be de-selected if the Add to Current Selection parameter is set to yes.  If the Add to
Current Selection parameter is set to no, all other selections will be cleared and the specified cell will remain
selected.

Parameter Name Description

Table Specifies which table the cell should be selected in.  The list of available tables will be
provided.

Row Specifies the row which should be selected.

Column Specifies the column which should be selected.

Add to Current
Selection

Determines whether or not the current selection should be cleared before selecting the
new cell.  Valid values are yes and no.

Select Table Row
The Select Table Row action will allow you to select a specified row within a table.  The action will fail if the
specified row is not within the range of available rows. 

Parameter Name Description

Table Specifies which table the cell should be selected in.  The list of available tables will be
provided.

Start Row Specifies the first row which should be selected.  The first row in the table is row 0.

End Row Specifies the last row which should be selected.  The first row in the table is row 0.  To
select only one row, the End Row should be set to the same value as the Start Row.
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Parameter Name Description

Add to Current
Selection

Determines whether or not the current selection should be cleared before selecting the
new row or rows.  Valid values are yes and no.

Select Item In Tree
The Select Item In Tree action allows you to select a specific item within a tree.  To specify the item, you must
specify the row which you would like to select.  The action will fail if the specified row is not valid.

Parameter Name Description

Tree Specifies which tree which the selection should occur in.  The list of available tree
controls will be provided.

Row Specifies the full path to the item you wish to select.

Add to Current
Selection

Determines whether or not the current selection should be cleared before selecting the
new row.  Valid values are yes and no.

Set Checkbox
The Set Checkbox action will turn a checkbox on or off depending on the new value you specify.  

Parameter Name Description

Checkbox to Set Specifies which checkbox should be set.

New Value Specifies whether the checkbox should be checked on or off.  The valid values are true
and false.  Specifying true for the New Value will turn the checkbox on.

Set Drop Down List
The Set Drop Down List action will select a new value within a drop down list. The action will fail if the
specified value cannot be found in the drop down list.  The name of the list will be added after the action name.

Parameter Name Description

New Value Specifies the new value for the drop down list.  If zsDuplicateHunter can determine the
valid values, they will be shown in a list.  Otherwise, you will need to review the
contents of the list to determine the valid values.  

Set Option Group
The Set Option Group action allows you to select from a set of options which are shown as option buttons.  The
name of the option set will be after the action name.

Parameter Name Description

New Value Specifies the new value to select for the set of options.  The list of valid options will be
provided for you.

Set Table Cell Value
The Set Table Cell Value action will allow you to select a change the contents of a cell within a table.  The
action will fail if the specified row or column is not within the range of available rows and columns.  The action
will also fail if the specified cell cannot be changed.
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Parameter Name Description

Table Specifies which table the cell should be selected in.  The list of available tables will be
provided.

Row Specifies the row of the cell to change.

Column Specifies the column of the cell to change.

New Value Specifies the new value which should be entered.

Show Dialog
The Show Dialog action will open a new dialog based on the type specified.  This action will fail if the dialog
cannot be opened.  The available dialogs which can be opened will be defined in the section of the help manual
defining the screen actions.

Parameter Name Description

Dialog to Open Specifies the dialog which should be opened.  The list of available dialogs will be pre-
filled for you to select from.

Take Screenshot
The Take Screenshot action will take a picture of the current screen or section of a screen and save it to the
specified file.  The format used will depend on the format specified.  This action will fail if the file specified
cannot be written to.

Parameter Name Description

Filename Specifies the file to save the screenshot to.  The filename should include the full path to
the file.

Format Specifies the format of the screenshot.  The list of formats will be system dependent.  

Create Thumbnail Determines whether or not zsDuplicateHunter will create a smaller version (thumbnail)
of the screenshot.  The thumbnail will be located in the same directory specified by
Filename, and will have the word -Thumb appended after the name of the filename.

Max Thumbnail Size Specifies the maximum width or height of the thumbnail.  The thumbnail will be scaled
to fit within the maximum size.  The size should be an integer greater than or equal to 1.
 It is specified in Pixels.

6.4.3 zsDuplicateHunter Main Window Actions
The Main Window is the starting point for all scripts.  If you wish to chain scripts together you should ensure
that the each script ends at the main dialog so the next script can resume correctly.

The Actions for the Main Window will allow you to navigate to other sections of the program.  The Main
Window actions also give you access to the functionality found in the File menu and the Help menu.

Add Folder To Search
The Add Folder To Search action allows you to add a folder to the list of folders to be searched.  

Parameter Name Description

Folder Path Specifies the full path to the folder you wish to search.

Call Script
The Call Script Action will load and run the script specified by the Script File parameter.  When calling scripts,
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you should try to ensure that the script ends at the Main Window.  Calling Scripts is highly recommended if are
planning to create a relatively large script because the Call Script action will allow you to break a larger script
into several smaller sections.

Parameter Name Description

Script Path Specifies the file or directory which should be loaded and run.  You should include the
full path to the script.  If a directory is specified, zsDuplicateHunter will load all scripts
in the directory and run them all (one at a time).  The scripts are sorted by name, so if
order is important for the scripts, you can start the name with 01, 02, 03, etc.

Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic Actions section of the
manual.  You can check if the following actions are enabled Cancel Duplicate Hunt, Collapse All, Delete All
Duplicates of File, Delete All Duplicates Except First, Delete All Duplicates Except Newest, Delete All
Duplicates Except Oldest, Delete All Files In This Folder Which Have Duplicates, Delete Selected Files,
Deselect All Files, Deselect All Files in Group, Expand Children, Find, Ignore Selected, Ignore Selected
and Duplicates of Selected, Keep Files In This Folder Delete Duplicates Elsewhere, Open Containing
Folder, Open Folders Containing Duplicates, Open in Viewer, Options, Replace Selected and Duplicates
of Selected With Links, Replace Duplicates With a Link to selected, Select All Files in Group, Select All
Files in Group Except Current, Session 1, Session 2, Session 3, Session 4, Session 5, Sort Results by
Grouping Information, Sort Results by Number of Duplicates, Start Deletion, and Start Duplicate Hunt.

Check List Row
The Check List Row action is a basic action which is described in the Basic Actions section of the manual.  You
can check the Folders To Search List.

Check Property
The Check Property action is a basic action which is described in the Basic Actions section of the manual.  The
following properties are available from the zsDuplicateHunter Main Window.

· Duplicate Hunt is Running - This property determines whether or not a duplicate hunt is currently being
loaded by the interface.  Valid values are true and false.

· Duplicate Hunt Status - This property returns the current status of the duplicate hunt.  Valid values are
Not Started, In Progress, Completed With Errors, and Completed.

· Duplicate Hunt Time - This property returns the elapsed time for the last duplicate hunt.  If no duplicate
hunt has been run, or if the current duplicate hunt is in progress, this property will return 0.

· File Sort Mode - Returns the method used to sort duplicate files within the results.  Valid values are By
Time Ascending, By Time Descending, and By Name.

· Group Sort Mode - Returns the method used to sort groups when the results are displayed by Group.
Valid values are By Number of Duplicates and By Grouping Information.

· Is Registered - returns whether or not the current program is Registered.  Valid values are true and false.  
· Number Duplicate Hunt Options - Returns the number of available options in the Duplicate Hunt

Options drop down list.
· Number Folders to Search - Returns the number of folders in the Folders To Search list.
· Number of Bytes Scanned - Returns the number of files that were scanned in the duplicate hunt.
· Number of Duplicates Found - Returns the number of duplicates that were found in the duplicate hunt.
· Number of Files Scanned - Returns the number of files that were scanned in the duplicate hunt.
· Number Result Rows - Returns the number of rows in the Duplicate Hunt Results Table.
· Selected Deletion Method - This property returns the name of the currently selected deletion method in

the Deletion Method drop down list.
· Selected Duplicate Hunt Options - This property returns the name of the currently selected options for

the Duplicate Hunt.
· Session (1-5) - Returns the full path of the most recently used session in each position.
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· View Filter - Returns whether or not Unique files are filtered from the results.  Valid Values are Show
Unique Only, Show All Files and Show Duplicates Only.

· View Mode - Returns whether the results are being displayed by Group or by Path as shown in the View
menu.  Valid values are By Group and By Path.

Check Row Expanded
The Check Row Expanded action will return whether or not the specified row is expanded.  The action will fail
if the specified row is not within the range of rows in the table.  You can change whether a row is expanded or
collapsed programmatically using the Expand Row action, Collapse All Action, or Expand Children Action.

Parameter Name Description

Row Specifies which row should be checked.  The first row in the table is row 0.

Expected Value Specifies whether or not the row is expected to be expanded or not.  The valid values
are true and false.

Check Table Column Width
This is a basic action which is described in the Basic Actions section of the manual.  You can check widths in
the Duplicate Hunt Results table.

Check Table Value
This is a basic action which is described in the Basic Actions section of the manual.  You can check values in
the Duplicate Hunt Results table.

Clear Folders To Search
This action will remove all folders from the list of folders to search.

Clear Last Used Sessions
The Clear Last Used Sessions action will remove the most recently used sessions from the File menu.

Clear Results
This action will clear the results and reset the status of the duplicate hunt.  It is functionally equivalent to
selecting the Clear Results menu item.

Collapse All
The Collapse All action will collapse any results which are currently open.  The functionality is equivalent to
selecting Collapse All from the results menu.

Deselect
The Deselect action will deselect rows based on the selected command.  It is functionally equivalent to selecting
the Deselect All Files or the Deselect All Files in Group menu item from the Results menu.  

Parameter Name Description

Deselect command Specifies the actual command to be run.  Valid values are Deselect All Files and
Deselect Files in Group.

Emulate Edition

The Emulate Edition action will cause the zsDuplicateHunter interface to change to look like another edition of
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zsDuplicateHunter.  This can be useful if you want to limit yourself to the functionality found in a less powerful
version or if you want to produce screenshots which appear to be from another edition of zsDuplicateHunter.  

Parameter Name Description

Edition to Emulate Specifies the edition to be emulated.  Valid values are Standard, Professional, and
Enterprise.

Expand Children
The Expand Children action will expand the specified row and all of the results which the specified result
contains.  It is functionally equivalent to selecting the Expand Children menu item from the Results menu.  The
action will fail if the specified row is not within the range of results which are currently displayed.

Parameter Name Description

Row Specifies which row should be expanded.  The first row in the table is row 0.

Expand Row
The Expand Row action will expand or collapse the specified row.  This action is functionally equivalent to
expanding or collapsing the result from the results table except that instead of just toggling the row between the
expanded and collapsed state, you can explicitly state if the row should be expanded or collapsed.  This action
will fail if the specified row is not within the range of results currently being displayed.

Parameter Name Description

Row Specifies which row should be expanded or collapsed.  The first row in the table is row
0.

New State Specifies whether or not the row should be expanded or not.  The valid values are
Expanded and Collapsed.

Export Results to CSV
This action will cause zsDuplicateHunter to export the current results to an CSV file.  This action is functionally
equivalent to selecting the Export to CSV File menu item from the File menu.  This action will fail if the
specified results file cannot be written to.

Parameter Name Description

File to Save to Specifies the name of the file which the results should be saved to.  You should include
the full path to the result file.

Ignore Files
This action allows you to ignore (or remove) files from the results based on what is selected within the results. 
This action includes all the different types of ignore commands available within the results menu.  The action
will fail if the specified command is not enabled.

Parameter Name Description

Ignore command Specifies the actual command to be run.  Valid values are Ignore Selected and Ignore
Selected and Duplicates of Selected.

Load Session
The Load Session action will cause zsDuplicateHunter to load a previously saved session and start the
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comparison.  The appropriate tab will also be selected based on the type of comparison saved in the session. The
load session action is functionally equivalent to selecting Load Session from the File menu.  This action will fail
if the specified session cannot be found.

Parameter Name Description

Session Name Specifies the session file which should be loaded.  You should include the full path to
the session.

Open File
This action allows you to open files and folders based on what is selected within the results.  This action includes
all the different types of open commands available within the results menu.  The action will fail if the specified
command is not enabled.

Parameter Name Description

Open command Specifies the actual command to be run.  Valid values are Open in Viewer, Open
Containing Folder, and Open Folders Containing Duplicates.

Remove Selected Folders
This action will remove any files which are currently selected in the Folders to Search List.  If no items are
selected, no items will be removed.

Run Command Line
This action allows you to run a command line from within zsDuplicateHunter.  This can be used on systems
where command line options are not easy to use (for example on Mac OS X), or to quickly automate
functionality which is supported by the command line interface.  It is not recommended that you use the /script
option and the /close option from within a script as they will interfere with the proper operation of the script you
are running.  If you run the /clearPrefs command, you must restart the program before all changes take effect.  It
is suggested that you include the /noWarnings option so that any warnings will be logged to the results and not
shown as warning dialogs.

Parameter Name Description

Command Line Specifies the command line which will be run by zsDuplicateHunter.  When specifying
a path which includes a space in it, you must enclose the path within quotes.

Save Results to HTML
The Save Results to HTML action will cause zsDuplicateHunter to save the current results to an HTML file.
This action is functionally equivalent to selecting the Save Results to HTML menu item from the File menu. 
This action will fail if the specified results file cannot be written to.  Before the results are saved, you will be
presented with an Options Dialog which will need to be filled out.  The file will be written after close the Options
Dialog using the OK button.

Parameter Name Description

File to Save to Specifies the name of the file which the results should be saved to.  You should include
the full path to the result file.

Save Results to XML
The Save Results to XML action will cause zsDuplicateHunter to save the current results to an XML file.  This
action is functionally equivalent to selecting the Save Results to XML menu item from the File menu.  This
action will fail if the specified results file cannot be written to.
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Parameter Name Description

File to Save to Specifies the name of the file which the results should be saved to.  You should include
the full path to the result file.

Save Session
The Save Session action will cause zsDuplicateHunter to save the current comparison settings as a session.  This
action is functionally equivalent to selecting the Save Session menu item from the File menu.  This action will
fail if the specified session file cannot be written to.

Parameter Name Description

Session Name Specifies the session file which should be saved.  You should include the full path to the
session.

Select All
The Select All action will select rows based on the specified command.  It is functionally equivalent to selecting
the Select All Files in Group or Select All Files in Group Except Current menu item from the Results menu.  

Parameter Name Description

Select All command Specifies the actual command to be run.  Valid values are Select All Files in Group and
Select All Files in Group Except Current.

Select List Row
This is a basic action which is described in the Basic Actions section of the manual.  You can select rows in the
Folders To Search list.

Select Table Row
This is a basic action which is described in the Basic Actions section of the manual.  You can select rows in the
Duplicate Hunt Results table.

Set Drop Down List
This is a basic action which is described in the Basic Actions section of the manual.  You can set items in the
Duplicate Hunt Options and Deletion Method lists.

Set File Sort Mode
This action allows you to change how duplicate files are sorted within the results.  Valid values are By Time
Ascending, By Time Descending, and By Name.

Parameter Name Description

Sort Mode Specifies how files should be sorted.  Valid values are By Time Ascending, By Time
Descending, and By Name.

Set Group Sort Mode
This action allows you to change how the groups are sorted within the results when viewing the results By
Group.  

Parameter Name Description

Sort Mode Specifies how groups should be sorted.  Valid values are By Number of Duplicates and
By Grouping Information.
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Set View Filter
This action controls whether or not unique files are filtered from the results.  This functionality is the same as the
functionality in the View menu.

Parameter Name Description

View Filter Specifies how the results should be displayed. Valid values are Show All Files'Show
Unique Only, and Show Duplicates Only.

Set View Mode
This action controls how the results are displayed.  This is equivalent to changing the View method in the View
menu.

Parameter Name Description

View Mode Specifies how the results should be displayed. Valid values are By Group and By Path.

Show Dialog
The Show Dialog action is a basic action which is described in the Basic Actions section of the manual.  The
following  dialogs can be shown from the zsDuplicateHunter Main Window.

· About - Equivalent to selecting the About menu item from the Help menu (or zsDuplicateHunter menu on
OS X).

· Add Folder to Search Dialog - Equivalent to selecting the Add Folder to Search button using the Custom
Explorer.  A file browse dialog will be shown which can be used to select a folder to search by browsing
or by using the favorites.

· Adjust Available Memory - Equivalent to selecting the 
· Check For Updates - Equivalent to selecting the Check for Updates menu item within the Help menu.
· Enter Registration Key - Equivalent to selecting Enter Registration Key from the Help menu.
· Find - Equivalent to selecting Find from the Results menu.
· Memory Monitor - Equivalent to selecting Memory Monitor from the Help menu.
· Options - Equivalent to selecting the Options menu item from the File menu, or selecting the Edit Options

button.
· Tip of the Day - Equivalent to selecting Tips from the Help menu.

Start Deletion
This option will start the process of deleting files based on the currently specified deletion method and currently
selected files or groups.  The action will fail if the currently specified deletion method is not enabled.

Parameter Name Description

Wait until Deletion
Finishes

Determines whether or not zsDuplicateHunter waits until the deletion has finished until
it returns control to the script.  Valid values are yes and no.

Maximum Time to
Wait

Specifies the maximum time to wait for the deletion to finish before continuing script
execution.

Expected Files to
Delete

Optionally specifies the list of files which are expected to be deleted. Files should be
separated by semi-colons.

Validate Files to
Delete

Determines whether or not zsDuplicateHunter should validate the expected files to
delete. Valid values are true and false. If this is set to true and the list of files does not
match, no files will be deleted.

Expect Files to be
Deleted Permanently

Deter mines whether you expect zsDuplicateHunter to delete the files permanently, or if
you expect them to be moved to the deletion folder. Valid values are true and false. If
this check fails, no files will be deleted.

Expected Files to
Replace with Links

Optionally specifies the list of files which are expected to be replaced with links. Files
should be separated by semi-colons.
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Validate Files to
Replace with Links

Determines whether or not zsDuplicateHunter should validate the expected files to be
replaced with links. Valid values are true and false. If this is set to true and the list of
files does not match, no files will be deleted.

Expected Files Not
Deleted

Optionally specifies the list of files which could not be deleted. Files should be
separated by semi-colons.

Validate Files Not
Deleted

Determines whether or not zsDuplicateHunter should validate the list of files which
could not be deleted. If this is set to true and the list does not match, the action will fail.

Start Duplicate Hunt
This action will start the duplicate hunt using the currently specified folders and options.  This action is
equivalent to selecting the Start Duplicate Hunt button.  The action will fail if the Start Duplicate Hunt button is
not enabled.

Parameter Name Description

Wait until Duplicate
Hunt Finishes

Determines whether or not zsDuplicateHunter waits until the duplicate hunt has finished
loading until it returns control to the script.  Valid values are yes and no.

Maximum Time to
Wait

Specifies the maximum time to wait for the duplicate hunt to finish before continuing
script execution.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Move Dialog, Resize Dialog, and
Take Screenshot.  For more information on these actions, see the Basic User Interface Actions section of the
manual. 

6.4.4 About Dialog Actions
The About Dialog shows basic information about zsDuplicateHunter.  From a scripting standpoint, it is not
overly interesting.  The actions for the About Dialog, simply let you navigate between the screens which can be
accessed from the About Dialog,  take screen captures, and close the dialog.

Show Dialog
The Show Dialog action is a basic action which is described in the Basic User Interface Actions section of the
manual.  The following  dialogs can be shown from the About Dialog.

· Diagnostics - Equivalent to selecting the Diagnostics button.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, and Take
Screenshot.  For more information on these actions, see the Basic User Interface Actions section of the manual. 

6.4.5 Adjust Available Memory Dialog Actions
The Adjust Available Memory Dialog allows you to control how much memory zsDuplicateHunter will use.
Any changes you make to this form will not be active until zsDuplicateHunter is restarted.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available.
· Maximum Memory to Allocate - Returns the maximum memory that zsDuplicateHunter will use.

Set Drop Down List
The Set Drop Down List action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can change the Maximum Memory to Allocate drop down list.  The valid options are: 64 MB,
128MB, 192 MB, 256 MB, 384 MB, 512 (.5 GB), 640 MB, 768 MB, 1024 MB (1 GB), 1536 MB (1.5 GB),
2048 MB (2 GB), 2560 MB (2.5 GB), 3072 MB (3 GB), 4096 MB (4 GB), 5120 MB (5 GB), 6144 MB (6 GB),
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7168 MB (7 GB), and 8192 MB (8 GB).

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 

6.4.6 Check For Updates Dialog Actions
The Check For Updates Dialog allows you to check for updates to zsDuplicateHunter.  You will not normally
need to use this screen while Scripting because the same functionality is available when zsDuplicateHunter starts
up.

Check For Updates
The Check For Updates action will start the check for updates process.  You have the ability to check for
updates on the current version as well as past versions.  In general, you will only want to check the current
version.  You will need to run the Check for Updates action before checking properties such as Update
Available.  This is equivalent to selecting the Check Now button.

Parameter Name Description

Version Specifies the version of zsDuplicateHunter which should be checked for updates.  If
the version is left blank, the current version will be checked.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available from the Check For Updates Dialog.
· Download URL - Returns the website URL where the latest version can be found.  It will be an empty string if

the Check For Updates Action has not been run, or if no update is available.
· Frequency to Check For Updates - Returns the frequency with which updates will be checked when the

program starts.  Valid options are: Never, At Startup, Daily, Weekly, and Monthly.
· New Version - Returns the number of the latest version.  It will be an empty string if the Check For Updates

Action has not been run, or if no update is available.
· Update Available - Returns whether or not an update is available.  It will be an empty string if the Check For

Updates Action has not been run, or if no update is available.  It will be true if an update is available and false
if no update is available.

· Update Benefits - Returns the benefits of the new version.  It will be an empty string if the Check For Updates
Action has not been run, or if no update is available.  

· Update Features - Returns a list of the key features in the new version of the program.  It will be an empty
string if the Check For Updates Action has not been run, or if no update is available. 

Set Drop Down List
The Set Drop Down List action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can change the Frequency drop down list in the Check For Updates Dialog.  The valid options
are: Never, At Startup, Daily, Weekly, and Monthly.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 
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6.4.7 Diagnostics Dialog Actions
The Diagnostics Dialog gives information about the current setup of the Java environment on your system.  This
information can be useful for debugging.  The Diagnostics Dialog is not very interesting from a scripting
standpoint.  The available actions simply allow you to take screen captures and save the diagnostics to a file.

Save Diagnostics to File
The Save Diagnostics to File action will save the diagnostics shown in the dialog to the specified file.  It is
equivalent to selecting the Save to File button.  If you wish to compare the diagnostics to a known state, it is
easiest to save the diagnostics to file and then compare them to a file which you have checked using the Compare
Files action.

Parameter Name Description

File to Save Specifies the path of the file to save to.  The full path of the file should be provided.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 

6.4.8 Enter Registration Key Dialog Actions
The Enter Registration Key Dialog allows you to enter a registration key into the program.  From a scripting
standpoint, you are not allowed to automate the process of entering registration keys.  Therefore, this screen will
not be used often in your scripts.  You can take a screenshot of the current screen if you wish.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, and Take
Screenshot.  For more information on these actions, see the Basic User Interface Actions section of the manual. 

6.4.9 File Browse Dialog Actions
The File Browse Dialog allows you to select files either by browsing for the files or by selecting from the
favorites.

Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic User Interface Actions
section of the manual.  You can check if the following actions are enabled Delete Favorite, Delete Selected,
Create New File, Create New Folder, Create New Zip File, and Create New Jar File.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available from the File Browse Dialog.
· Favorites Count - Returns the number of Favorites which are currently available.
· Favorites Tab Visible - Returns whether or not the Favorites tab is visible.  It will not be visible if favorites

are not supported, or if the use of favorites is turned off.
· Favorites Sort Mode - Returns the current sort mode for the favorites.  Valid values are Path, Last Used, and

Frequency.
· Selected File Explorer - Returns the full path of the file which is currently selected in the Explorer Tab.  Will

be a blank string if nothing is selected.
· Selected File Favorites - Returns the full path of the file which is currently selected in the Favorites Tab.

Will be a blank string if nothing is selected.
· Title - Returns the Title of the dialog which will change based on what is being selected.
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Check Table Value
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can check the values in the Favorites Table.

Create New
The Create New action allows you to create new Files and Folders under the currently selected folder in the
Explorer tab.  The action will fail if there is not a currently selected item, if the desired action is not enabled, or if
the new item cannot be created.  This is functionally equivalent to selecting one of the Create New methods from
the toolbar or context menu.

Parameter Name Description

Type to Create Specifies the type of item which should be created.  Valid values are File, Folder, Zip
File, and Jar File.

New Name Specifies the name of the item that should be created.  In this case, the full path should
not be specified, just the name.

Delete Favorite
The Delete Favorite action will delete the currently selected item in the Favorites table.  The action will fail if
there is not a currently selected favorite.  This is functionally equivalent to selecting the Delete Favorite button.

Delete Selected
The Delete Selected action will delete the currently selected file or folder in the Explorer tab.  The action will
fail if there is not a currently selected item, or if the selected item could not be deleted. This is functionally
equivalent to selecting the Delete button from the toolbar or context menu.

Expand Tree Node
The Expand Tree Node action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can expand nodes in the Explorer tree.

Refresh
The Refresh action will refresh the currently selected node or the entire tree depending on the Refresh Type
parameter.  This functionality is equivalent to selecting the Refresh or Refresh All buttons from the toolbar or
context menu.

Parameter Name Description

Refresh Type Specifies the type of refresh to perform.  Valid values are Refresh All and Refresh
Selected.

Select File in Tree
The Select File in Tree action allows you to specify the path of a file or folder which should be selected in the
Explorer tree.  If the path does not exist, the action will fail.

Parameter Name Description

Path to Select Specifies the full path of the file which should be selected in the tree.

Select Item in Tree
The Select Item in Tree action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can select items in the Explorer tree.
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Select Tab
The select Tab action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas from the File Browse Dialog.

· Explorer - Switches to the Explorer Tab of the File Browse Dialog.
· Favorites - Switches to the Favorites Tab of the File Browse Dialog.

Select Table Row
The Select Table Row action is a basic action which is described in the Basic Actions section of the manual.
You can select items in the Favorites table.

Set Option
The Set Option action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can change the options for the Sort By Group.  The valid values are: Path, Last Used, and
Frequency.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 

6.4.10 File Selection Window Actions
The File Selection Window allows you to change the currently selected file or folder.  The File Selection
Window is used on a number of screens where you need to specify a file or folder.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.

Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic User Interface Actions
section of the manual.  You can check if the following actions are enabled Favorites.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available.

· Filename - returns the full path to the file which is currently specified.
· Filename Exists - returns whether or not the currently specified filename exists.  Valid values are true and

false.  If you check this property immediately after entering text, you may need to pause for about 50
milliseconds to give the property time to update.

· Title - returns the title (displayed to the left or above the text box) which identifies the purpose of the File
Selection Window.

Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can enter text into the file/folder name text box.

Show Dialog
The Show Dialog action is a basic action which is described in the Basic Actions section of the manual.  The
following  dialogs can be shown from the File Selection Window.

· Browse Dialog - Equivalent to selecting the Browse button.
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· Favorites Dialog - Equivalent to selecting the Favorites button.

6.4.11 Find Dialog Actions
The Find Dialog allows you to search the results to find specific items within the results.  

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.

Check List Row
The Check List Row action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can check the contents of the Find drop down list, Search In list, and the Search Results list.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:

· Find Text - Returns the text which zsDuplicateHunter will search for.
· Find - Number of Rows - Returns the number of rows that are currently contained in the Find drop down

list.
· Match Case - Returns whether or not the Match Case check box is selected.  Valid values are true and

false.
· Search Direction - Returns the direction of the search.  Valid values are Search Up and Search Down.
· Search In - Number of Rows - Returns the number of rows that are currently contained in the Search In

List.
· Search In - Selected Rows -  This property contains the rows that have been selected.  The first row is 0.

If more than one row is selected, they will be separated by commas.  For example, if the first, second, and
fourth items are selected, the property will return 0,1,4.  You can change which rows are selecting using
the Select List Row Action.

· Search Results - Number of Rows - Returns the number of rows that are currently contained in the
Search Results List.

· Search Results - Selected Rows -  This property contains the rows that have been selected.  The first row
is 0.  If more than one row is selected, they will be separated by commas.  For example, if the first,
second, and fourth items are selected, the property will return 0,1,4.  You can change which rows are
selecting using the Select List Row Action.

· Use Regular Expressions - Returns whether or not the Use Regular Expressions check box is selected.
Valid values are true and false.

· Whole Words Only - Returns whether or not the Whole Words Only check box is selected.  Valid values
are true and false.

Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Enter Text in the Find text box.

Find
The Find action will start the search using the specified settings.  This is functionally equivalent to selecting the
Find Next or Find All button.

Parameter Name Description

Search Type Specifies the Type of Search that should be done.  Valid values are Find Next and Find
All.
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Successful Search
Expected

Specifies whether or not you expect the search to be successful (one or more results
returned).

Select List Row
The Select List Row action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Select List Rows for the Search In list, and the Search Results list.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following check boxes: Whole Words Only, Match Case, and Use Regular
Expressions.

Set Option
The Set Option action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following options in the Search Direction group: Search Up and Search Down.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 

6.4.12 HTML Report Options Dialog Actions
The HTML Report Options Dialog allows you to change the options which are used when saving HTML reports.
 

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:

· Footer Text - Returns the text which will be used as the footer in the report.
· Font Size - Returns the relative size of the font that will be used.  Valid values are xx-small, x-small,

medium, large, x-large, and xx-large.
· Header Text - Returns the text which will be used as the header in the report.
· Include Date Printed - Returns whether or not the Include Table Borders checkbox is selected.  Valid

values are true and false.
· Include Directories Searched - Returns whether or not the Include Directories Searched checkbox is

selected.  Valid values are true and false.
· Include Options Used - Returns whether or not the Include Options Used checkbox is selected.  Valid

values are true and false.
· Include Table Borders - Returns whether or not the Include Table Borders checkbox is selected.  Valid

values are true and false.
· Results to Show - Returns which results will be displayed in the results.  Valid values are Include Visible

Results Only and Include All Results.
· Title - Returns the title which will be used in the report.
· View Report After Creation - Returns whether or not the View Report After Creation checkbox is

selected.  Valid values are true and false.

Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Enter Text in the Title, Header Text, and Footer Text text boxes.



Scripting zsDuplicateHunter 95

© 2006 Zizasoft, LLC

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following check boxes: Include Date Printed, Include Directories Searched, Include
Options Used, Include Table Borders, and View Report After Creation.

Set Drop Down List
The Set Drop Down List action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can change the Font Size drop down list.  The valid options are: xx-small, x-small, medium,
large, x-large, and xx-large.

Set Option
The Set Option action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following options in the Results to Show group: Include Visible Results Only and
Include All Results.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual.  

6.4.13 Memory Monitor Dialog Actions
The Memory Monitor Dialog shows basic information about zsDuplicateHunter.  From a scripting standpoint, it
is not overly interesting.  The actions for the Memory Monitor Dialog, lets you get information about the current
amount of memory being used,  take screen captures, and close the dialog.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available from the Memory Monitor Dialog.  All of the memory values
are measured in megabytes.
· Allocated Memory - Returns the amount of memory which zsDuplicateHunter is currently using.  This

includes some free memory which zsDuplicateHunter has asked the system for, but is not currently using.  
· Current Memory Usage - Returns the current amount of memory which zsDuplicateHunter is actively using.
· Free Memory - Returns the amount of memory which zsDuplicateHunter has asked the system for, but is not

currently using.
· Peak Memory Usage - Returns the maximum amount of memory which zsDuplicateHunter has actively used

since the Memory Monitor was first opened.
· Total Memory Available - Returns the maximum amount of memory which zsDuplicateHunter can request

from the system.

Reclaim Memory
The Reclaim Memory Action allows you to reclaim any memory which zsDuplicateHunter has allocated, but is
not actually using.  This is functionally equivalent to selecting the Reclaim Memory button.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 
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6.4.14 Options Dialog Actions
The Options Dialog allows you to set various options to control the behavior of zsDuplicateHunter.  You will use
the actions on each tab of the options dialog to actually set and change the settings.  From the main Options
Dialog, you can create screenshots and close the dialog as well as performing actions related to the overall usage
of the Options Dialog.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas from the Freeform Comparison Tab.

· File Browsing - The File Browsing Tab. 
· File Deletion - The File Deletion Tab.
· Link Creation Rules - The Link Creation Rules Tab.
· Checksums - The Checksums Tab.
· Timestamps - The Timestamps Tab.
· Scripting - The Scripting Tab.
· Duplicate Hunt - The Duplicate Hunt Tab.

Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic User Interface Actions
section of the manual.  You can check if the following actions are enabled Link Creation Rules, and Scripting.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:

· All Options are Valid - Determines if all options on all tabs are valid.  Valid Values are true and false.
· Current Tab - returns the tab which is currently active on the Options Dialog.  Valid values are:  File

Browsing, File Deletion, Link Creation Rules, Checksums, Timestamps, Scripting, and Duplicate Hunt.  
· Duplicate Hunt Options Saved - Returns whether or not the current set of Duplicate Hunt Options has

been saved or not.  Valid Values are true and false.
· Validation Errors - Returns any errors that were encountered during validation which will prevent the

dialog from being closed with the OK button.
· Warnings - Returns any warnings which will be displayed when the dialog is closed with the OK button.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 

6.4.14.1 File Browsing Options Actions

The File Browsing Tab allows you to change options related to how zsDuplicateHunter allows you to search for
files.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.

Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic User Interface Actions
section of the manual.  You can check if the following actions are enabled Browse Using Windows Explorer,
Browse Using Finder, and Browse Using System Explorer.
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Check Property
The Check Property action is a basic action which is described in the Basic Actions section of the manual.  The
following properties are available:

· Browse Type - Returns which option is selected for the Browse method.  Valid values are Browse Using
Windows Explorer, Browse Using Finder, Browse Using System Explorer, and Browse Using Custom
Explorer.

· Remember Favorites - Returns whether or not the Remember Favorites checkbox is selected.  Valid
Values are true and false.

· Remember Last Used Paths - Returns whether or not the Remember Last Used Paths checkbox is
selected.  Valid Values are true and false.

· Show Hidden Files - Returns whether or not the Show Hidden Files checkbox is selected.  Valid Values
are true and false.

· Show System Files - Returns whether or not the Show System Files checkbox is selected.  Valid Values
are true and false.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following check boxes: Remember Favorites, Remember Last Used Paths, Show
Hidden Files, and Show System Files.

Set Option
The Set Option action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following options in the Browse Type group: Browse Using Windows Explorer,
Browse Using Finder, Browse Using System Explorer, and Browse Using Custom Explorer.  You can use
Browse Using System Explorer to set the Windows Explorer or Finder as well. 

6.4.14.2 File Deletion Options Actions

The File Deletion Tab allows you to change settings related to how files and folders are deleted.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.
· Delete Folder - Sets focus to the Delete Folder File Selection Folder.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:

· Automatically Delete Folders When All Files Have Been Deleted - Returns whether or not the
Automatically Delete Folders When All Files Have Been Deleted checkbox is selected.  Valid Values are
true and false.

· Delete Folder - Returns the folder which will be used when the Delete To Folder deletion method is
selected.

· Deletion Type - Returns which option is selected for the Deletion Type.  Valid values are Delete
Permanently.

· Remember Path For Files when deleting to Folder - Returns whether or not the Remember Path For
Files when deleting to Folder checkbox is selected.  Valid Values are true and false.

· Overwrite Read-only files on copy - Returns whether or not the Overwrite Read-only files on copy
checkbox is selected.  Valid Values are true and false.

· Treat Folders with Hidden Files Only as Empty - Returns whether or not the Treat Folders with
Hidden Files Only as Empty checkbox is selected.  Valid Values are true and false.
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· Warn when deleting a file permanently - Returns whether or not the Warn when deleting a file
permanently checkbox is selected.  Valid Values are true and false.

· Warn when overwriting newer files - Returns whether or not the Warn when overwriting newer files
checkbox is selected.  Valid Values are true and false.

Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Enter Text in the Delete Folder text box.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the following check boxes: Automatically Delete Folders When All Files Have Been
Deleted, Overwrite Read-only files on copy, Treat Folders with Hidden Files Only as Empty, Warn when
deleting a file permanently, and Warn when overwriting newer files.

Set Option
The Set Option action is a basic action which is described in the Basic Actions section of the manual.  You can
set the following options:

· Deletion Type group: Delete Permanently and Delete To Folder.

6.4.14.3 Link Creation Rule Actions

The Link Creation Rules tab allows you to define how links will be created when files are deleted.  

Add Rule
The Add Rule action will add a new row to the link creation rules table.  It is functionally equivalent to selecting
the Add Rule button.

Parameter Name Description

Source Directory Specifies the full path to the source directory for the rule.

Include Sub Folders Specifies whether or not sub folders should be included when creating aliases

Destination Directory Specifies the full path to the directory where files should be moved when creating links.

Preserve Directory
Structure

Specifies whether or not the directory structure of the Source Directory will be
preserved in the Destination Directory.

Conflicting File
Action

Determines what should be done if a file already exists in the destination directory
which has different contents than the file being deleted.  Valid values are Use Latest
Version, Cancel Deletion, Replace Destination File, Link to Destination, Add Version
Number to File, Prompt.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:
· Linking Enabled - Returns whether or not the Linking Enabled checkbox is checked on.  Valid values are true

and false.
· Number Link Rules - Returns the number of rows in the Link Creation Rules table.
· Unmatched File Option - Returns how unmatched files will be handled.  Valid values are Delete File,
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Preserve File, and Prompt.

Check Table Value
The Check Table Value action is a basic action which is described in the Basic User Interface Actions section
of the manual.  You can check the values in the Link Creation Rules Table.

Clear Rules
This action will remove any rules which are currently defined.  It is equivalent to selecting all of the rules and
then selecting the Remove Rule(s) button.

Move Rule
This action will move the currently selected rules either up or down in the list of rules.  

Parameter Name Description

Move Direction Specifies whether or not the rules should move up or down.  Valid values are Move Up
and Move Down.

Remove Rule
The Remove Rule action will remove the currently selected row or rows from the link creation rules table.  It is
functionally equivalent to selecting the Remove Rule button.

Select Table Cell
The Select Table Cell action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can select cells in the Link Creation Rules Table.

Select Table Row
The Select Table Row action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can select rows in the Link Creation Rules Table.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the Linking Enabled check box.

Set Option
The Set Option action is a basic action which is described in the Basic Actions section of the manual.  You can
set the following options:

· Unmatched File Option group: Delete File, Preserve File, and Prompt.

Set Table Cell Value
The Set Table Cell Value action is a basic action which is described in the Basic User Interface Actions section
of the manual.  You can set cells within in the Link Creation Rules Table.

6.4.14.4 Checksum Options Actions

The Checksum Tab allows you to change settings related to how the checksum of files is calculated.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.
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Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic User Interface Actions
section of the manual.  You can check if the following actions are enabled Digest Calculation and Input Buffer
Size.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:
· Checksum Calculation - Returns the currently selected Checksum Calculation method.  Valid values are

Adler32 and CRC32.
· Digest Calculation - Returns the currently selected Digest Calculation method.  Valid values are MD5, SHA-

1, SHA-1, SHA-256, SHA-384, and SHA-512.
· Input Buffer Size - Returns the input buffer size used by the program.  Valid values are 1 KB, 8 KB, 16 KB,

32 KB, 64 KB, 128 KB, 256 KB, 512 KB, and 1 MB.
· Show Checksum as Hex - Returns whether or not the Show Checksum as Hex checkbox is selected.  Valid

values are true and false.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the Show Checksum as Hex check box.

Set Drop Down List
The Set Drop Down List action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can change the following drop down lists:

· Checksum Calculation - Valid values are Adler32 and CRC32.
· Digest Calculation - Valid values are MD5, SHA-1, SHA-256, SHA-384, and SHA-512.
· Input Buffer Size - Valid values are 1 KB, 8 KB, 16 KB, 32 KB, 64 KB, 128 KB, 256 KB, 512 KB, and

1 MB.

6.4.14.5 Timestamp Options Actions

The Timestamp Tab allows you to change settings related to how times and dates are displayed.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.

Check List Row
The Check List Row action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can check the contents of the Current Time zone drop down list.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:
· Timestamp Format - Returns the current format used to display timestamps.
· Sample Timestamp - Returns the sample timestamp using the current format.
· Current Time zone - Returns the current time zone which has been selected.
· Current Time zone - Number of Rows - Returns the number of rows in the Current Time zone drop down

list.
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Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Enter Text in the Timestamp Format text box.

Set Drop Down List
The Set Drop Down List action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can change the Current Time zone drop down list.  The valid options will depend on the
system you are running zsDuplicateHunter on.

6.4.14.6 Scripting Options Actions

The Scripting Options tab allows you to modify settings related to scripting including where scripts should be
saved, where results should be stored, and what is displayed after a script has been run.  Scripting Options are
only available in the Professional Edition.  

Add Global Variable
The Add Global Variable action will add an empty row to the global variables table.  It is functionally
equivalent to selecting the Add Global Variable button.

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.
· Scripts Folder - Sets focus to the Scripts Folder File Selection Folder.
· Results Folder - Sets focus to the Results Folder File Selection Folder.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:

· Include Date In Report Filename - Returns whether or not the Include Date In Report Filename
checkbox is selected.  Valid Values are true and false.

· Log actions during run - Returns whether or not the Log actions during run checkbox is selected.  Valid
values are true and false.

· Log Errors during run - Returns whether or not the Log errors during run checkbox is selected.  Valid
values are true and false.

· Number of Global Variables - Returns the number of rows in the Global Variables Table.
· Results Display Type - Returns which option is selected for the Results Display Type.  Valid values are

Display Full Results After Run, Display Pass/Fail After Run, and Display Nothing After Run.
· Results Folder - Returns the folder which the results of scripts will be saved to.
· Scripts Folder - Returns the folder which will be used as the default path when opening and saving

scripts.
· Show Script Monitor - Returns whether or not the Show Script Monitor checkbox is selected.  Valid

values are true and false.
· Track History of Script Runs - Returns whether or not the Track History of Script Runs checkbox is

selected.  Valid values are true and false.

Check Table Value
The Check Table Value action is a basic action which is described in the Basic User Interface Actions section
of the manual.  You can check the values in the Global Variables Table.

Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
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manual.  You can Enter Text in the Results Folder and Scripts Folder.

Remove Global Variable
The Remove Global Variable action will remove the currently selected row or rows from the global variables
table.  It is functionally equivalent to selecting the Remove Global Variable button.

Select Table Cell
The Select Table Cell action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can select cells in the Global Variables Table.

Select Table Row
The Select Table Row action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can select rows in the Global Variables Table.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the Include Date In Report Filename, Log actions during run, Log errors during run,
Show Script Monitor, and Track History of Script Runs check boxes.

Set Option
The Set Option action is a basic action which is described in the Basic Actions section of the manual.  You can
set the following options:

· Results Display Type group: Display Full Results After Run, Display Pass/Fail After Run, and
Display Nothing After Run.

Set Table Cell Value
The Set Table Cell Value action is a basic action which is described in the Basic User Interface Actions section
of the manual.  You can set cells within in the Global Variables Table.

6.4.14.7 Duplicate Hunt Options Actions

The Duplicate Hunt Options Tab allows you to modify the pre-defined options for zsDuplicateHunter and create
new sets of options.  

Change Focus
The Change Focus action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas:

· Previous - Returns you to the previous dialog.

Check Action Enabled
The Check Action Enabled action is a basic action which is described in the Basic User Interface Actions
section of the manual.  You can check if the following actions are enabled Duplicate Hunt Priority, Remaining
Time Estimation, Perform Binary Check, Group by Path, Group by Extension, Group by Timestamp,
Search Zip Files, Ignore System Files, Ignore Shortcuts, Size Filter Criteria 1, Size Filter Criteria 2,  Time
Filter Type, Time Filter Criteria 1, Time Filter Criteria 2, and Use Regular Expressions.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available:

· Available Options - Returns a list of options which are currently available.  The list is separated with
semi-colons.
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· Current Tab - Returns which tab is active.  Valid values are Grouping Options and Filter Options.
· Duplicate Hunt Priority - Returns the active priority for the Duplicate Hunt.  Valid values are High,

Normal, and Low.
· Filter Scope - Returns the Scope of the filter.  Valid values include Files, Files and Folders, and Folders

.
· Filter Action - Returns how the filter will be applied.  Valid values are Include Matches and Exclude

Matches.
· Filter Part - Returns what part of the file the filter should be applied to.  Valid values are Filter Name

Only and Filter Full Path.
· Filter Criteria - Returns the pattern which will be used to filter the files.
· Group by Name - Returns whether or not the Group by Name checkbox is selected.
· Group by Size - Returns whether or not the Group by Size checkbox is selected.
· Group by Checksum - Returns whether or not the Group by Checksum checkbox is selected.
· Group by Digest - Returns whether or not the Group by Digest checkbox is selected.
· Include Unique Files in Results - Returns whether or not the Include Unique Files in Results checkbox is

selected.
· Group by Path - Returns whether or not the Group by Path checkbox is selected.
· Group by Extension - Returns whether or not the Group by Extension checkbox is selected.
· Group by Timestamp - Returns whether or not the Group by Timestamp checkbox is selected.
· Number of Options - Returns the number of saved options which are available.
· Perform Binary Check - Returns whether or not the Perform Binary Check checkbox is selected.
· Remaining Time Estimation - Returns how zsDuplicateHunter will estimate how much time is left in the

duplicate hunt.  Valid values are: Calculate Number of Files to Search Before starting duplicate hunt.
, Calculate Number of Files to Search during duplicate hunt., and Do not estimate time remaining.

· Search Zip Files - Returns whether or not the Search Zip Files checkbox is selected.
· Search Sub Folders - Returns whether or not the Search Sub Folders checkbox is selected.
· Selected Options - Returns the saved option which is currently selected.Search Sub Folders - Returns

whether or not the Search Sub Folders checkbox is selected.
· Show Deletion Method Details - Returns whether or not the Show Deletion Method Details checkbox is

selected.
· Size Filter Type - Returns the current setting for the type of size filtering that will be done.  Valid values

are Anything, Less than, Less than or equal to, Between, Greater than, and Greater than or equal to
.

· Size Filter Criteria 1 - Returns the first size criteria which is used for all Filter Types except Anything.
· Size Filter Criteria Units - Returns the units for the size criteria.  Valid values are bytes, KB, MB, and

GB.
· Size Filter Criteria 2 - Returns the second size criteria which is used for all the Between Filter Types.
· Time Filter Type - Returns the current setting for the type of size filtering that will be done.  Valid values

are Anything, Earlier than, Earlier than or equal to, Between, Later than, and Later than or equal
to.

· Time Filter Criteria 1 - Returns the first time criteria which is used for all Filter Types except Anything.
· Time Filter Criteria 2 - Returns the second time criteria which is used for all the Between Filter Types.
· Use Regular Expressions - Returns whether or not the Use Regular Expressions checkbox is selected.

Valid values are true and false.
· Ignore Hidden Files - Returns whether or not the Ignore Hidden Files checkbox is selected.  Valid values

are true and false.
· Ignore System Files - Returns whether or not the Ignore System Files checkbox is selected.  Valid values

are true and false.
· Ignore Shortcuts/Aliases - Returns whether or not the Ignore Shortcuts or Ignore Aliases checkbox is

selected.  Valid values are true and false.

Delete Saved Option
The Delete Saved Option action allows you to delete the currently selected saved option as if you had selected



zsDuplicateHunter  User's Guide104

© 2006 Zizasoft, LLC

the Delete Saved Options button. 

Enter Text
The Enter Text action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Enter Text in the Filter Criteria, Size Filter Criteria 1, Size Filter Criteria 2, Time Filter
Criteria 1, and Time Filter Criteria 2 text boxes.

Reload Current Option
This action will reload the options from the saved options discarding any changes which were made since options
were last saved.

Save Options
The Save Options action allows you to save the currently selected options name.  The action will fail if the
options cannot be saved for any reason.

Save Options As
The Save Options as action allows you to save the currently selected options name.  The action will fail if the
name is not valid, the file cannot be written to, or a set of saved options already exists with the specified name.

Parameter Name Description

New Option Name Specifies the new name for the set of options.

Select Tab
The select Tab action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can Set Focus to the following areas of the Options Group set of tabs.

· Comparison Options - Switches to the Comparison Options Tab.
· Filters - Switches to the Filters Tab.

Set Active Saved Option
The Set Active Saved Option action allows you to set the active set of saved options to a specified value.  The
action will fail if the specified option is not found.

Parameter Name Description

Option Name Specifies the name of the saved option which you would like to set as current.  

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can set the Group by Name, Group by Size, Group by Checksum, Group by Digest, Group by
Path, Group by Extension, Group by Timestamp, Ignore Hidden Files, Ignore System Files, Ignore
Shortcuts, Include Sub Folders, Include Unique Files In Results, Perform Binary Check, Search Sub
Folders, Search Zip Files, and Show Deletion Method Details check boxes.

Set Drop Down List
The Set Drop Down List action is a basic action which is described in the Basic User Interface Actions section of
the manual.  You can change the following drop down lists:

· Duplicate Hunt Priority - Valid values are High, Normal, and Low.
· Filter Scope - Valid values are Files, Files and Folders, and Folders.
· Filter Action - Valid values are Include Matches and Exclude Matches.
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· Filter Part - Valid values are Filter Name Only and Filter Full Path.
· Remaining Time Estimation - Valid values are Calculate Number of Files to Search Before starting

duplicate hunt., Calculate Number of Files to Search during duplicate hunt., and Do not estimate
time remaining.

· Size Filter Type - Valid values are Anything, Less than, Less than or equal to, Between, Greater
than, and Greater than or equal to.

· Size Filter Criteria Units -   Valid values are bytes, KB, MB, and GB.
· Time Filter Type - Valid values are Anything, Earlier than, Earlier than or equal to, Between, Later

than, and Later than or equal to.

6.4.15 Tip of the Day Dialog Actions
The Tip of the Day Dialog gives information about the program.  From a scripting perspective, you will probably
not need to use this dialog.  However, you can retrieve information about the number of available tips, the
current tip, etc.

Check Property
The Check Property action is a basic action which is described in the Basic User Interface Actions section of
the manual.  The following properties are available from the Tip of the Day Dialog.  
· Current Tip Index - Returns the index of the current tip which is being shown.  The first tip in the list is 0.
· Current Tip - Returns the text of the current tip being shown.
· Number of Tips - Returns the number of tips which are available for viewing.  
· Show Tips at Startup - Returns whether or not Tips are shown when the program starts.  The value will be

true if they are shown, and false if they are not.

Go to Tip
The Go to Tip action allows you to navigate between the various tips.  You will need to specify which tip you
wish to make active.  Specifying Next for the Tip to Go to is equivalent to Selecting the Next Tip button.  The
functionality to jump to any specific tip is available only with the scripting interface.

Parameter Name Description

Tip to Go To Specifies the tip which the program should move to.  This can either be the number of
the tip (0 is the first tip), or the word Next which indicates that zsDuplicateHunter
should set focus to the next tip in the sequence.

Set Checkbox
The Set Checkbox action is a basic action which is described in the Basic User Interface Actions section of the
manual.  You can change the Show Tips at Startup checkbox in the Tip of the Day Dialog.

Basic User Interface Actions
In addition to these actions, you can use the Basic User Interface Actions - Close Dialog, Move Dialog, Resize
Dialog, and Take Screenshot.  For more information on these actions, see the Basic User Interface Actions
section of the manual. 
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7 Understanding Regular Expressions

Regular Expressions are a powerful method of searching for text. Regular expressions are text patterns that are
described using tokens. There are tokens to describe individual characters, words, punctuation, white space and
more.  Regular expressions should be considered an advanced topic, and if you do not feel comfortable using
regular expressions you should continue to use regular matching.

The following is a list of all the tokens you can use with a description of what the token does.

Token Description

. Matches any character

\d Matches a single digit from 0-9

\D Matches any character that is not a digit from 0-9 including white space

\w
Matches a single word character including upper and lowercase letters from a to z and
digits from 0-9 and the underscore character _

\W Matches any non word character

\t The tab character

\n The new line (linefeed) character

\r The carriage-return character

\f The form-feed character

$ Matches the end of a line

^ Matches the start of a line

\s
Matches a white space character including new line, carriage-return, tab, form-feed, and
end-of-line.

\S Matches any non white space character

\b
Matches a word boundary which is the character immediately before the start of a word (a
character matching \w). Normally this matches a space, tab, end of line, or beginning of
line.

\B Matches a non word boundary

{ Defines the start of a range

} Defines the end of a range

( Defines the start of a group

) Defines the end of a group

| A symbol meaning OR

* Indicates the preceding should be repeated zero or more times

+ Indicates the preceding should be repeated one or more times

? Indicates the preceding should be repeated zero or one times

{n} Indicates the preceding should be repeated n times

{n,} Indicates the preceding should be repeated at least n times

{n,m} Indicates the preceding should be repeated at least n times but no more than m times

\
The following character should not be a meta character (allows you to match reserved
characters like \, +, ., *, {, }, [, ], ?, ^, $, (, ))

In addition to these tokens, you can create character classes to match a single character to a user defined set of
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characters.

Pattern Description

[abc] Matches the characters within the brackets (in this case, abc)

[^abc] Matches anything except the characters within the brackets (in this case, anything except
abc)

[a-g] Matches the characters a range of characters starting at the letter before the hyphen and
ending at the letter after the hyphen (in this case, abcdefg)

[a-gm-p] Matches the characters in two ranges (in this case, abcdefgmnop)

[a-g[m-p]] Same as above

[a-z&&[m-p]] The intersection of the sets a-z and m-p (in this case, mnop)

[a-z&&[^m-p]] Subtracts a set from another set (in this case, all letters from a-z except mnop)

Additionally, there are predefined Portable Operating System Interface for UNIX (POSIX) character classes
which define common character classes.

Pattern Description

\p{Lower} Matches lower case letters from a to z

\p{Upper} Matches upper case letters from A to Z

\p{ASCII} Matches all ASCII characters

\p{Alpha} Matches all upper and lower case characters

\p{Digit} Matches all digits from 0 to 9

\p{Alnum} Matches all numbers and letters

\p{Punct} Matches all punctuation symbols

\p{Graph} Matches all visible characters

\p{Print} Matches all printable characters

\p{Blank} Matches a tab or space

\p{Cntrl} Matches a control character

\p{XDigit} Matches a hexadecimal digit

\p{Space} Matches a white space character

If you have additional questions about using regular expressions, please feel free to contact Zizasoft support at 
support@zizasoft.com.
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8 Technical Support

Zizasoft is committed to providing our users with outstanding technical support.   The following sections
describe what to do if you ever have a question about using zsDuplicateHunter.

8.1 Revision History
The following topics give the full revision history of zsDuplicateHunter from initial release to the current
release. 

8.1.1 Version 2.30

Core Functionality Updates 
· Added a new Enterprise Edition with functionality appropriate to business users including network

administrators.
· Added the ability to perform a binary comparison of files to ensure that they are exact duplicates.  The fast

binary check is optimized to take as little time as possible. This functionality is only available in the
Professional and Enterprise editions of zsDuplicateHunter.

· Added the ability to export results to a CSV file for easy import into other programs.  This functionality is only
available in the Professional and Enterprise Editions of zsDuplicateHunter.

· Added the display of information about the currently selected file. The program will also preview any images
which it recognizes.

· Added the ability to filter files to be searched based on the date that they were last modified.  This
functionality is only available in the Professional and Enterprise Editions of zsDuplicateHunter.

· Improved the installation of zsDuplicateHunter especially on Mac OS X and Linux.
· Fixed compatibility issues with Intel based Macintoshes.
· Added the ability to only show unique files in the results.
· Reorganized the Options screen to make the options easier to navigate.
· Reorganized the Main screen to make selecting the folders to search easier to understand and to emphasize the

step by step nature of removing duplicate files.
· Added a progress dialog when saving HTML and XML reports.  Also, fixed to avoid out of memory errors

when saving reports.
· Added the ability to control how the remaining time to complete the duplicate hunt is calculated.
· Added the ability to control the priority of the duplicate hunt.
· Added the ability to hide the descriptions of each deletion method.
· Added the ability to modify the maximum amount of memory which will be used by zsDuplicateHunter.

Replace File with Link Functionality
· Added the ability to replace a file with a link (shortcut on Windows, Alias on OS X, link on Linux) when a file

is deleted.  This functionality is only available in the Enterprise Edition of zsDuplicateHunter.
· Added Replace Selected Files with links deletion method which allows you to selectively replace files with

links.
·  Added Replace Duplicates With Link to Selected. which

Options Functionality
· Added the ability to save sets of options for future use.
· Added the ability to easily change between sets of options from the main comparison screen.
· Added the ability to specify the current option set using a command line option.

Scripting Functionality
· Added the ability to create and save scripts in the Professional version of zsDuplicateHunter.  Scripts give

access to functionality which is not available in the command line interface, and they are easier to use on non-
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Windows based systems.
· Added the ability to run a script from the command line and to double-click on a script to run it.

General Fixes
· Fixed so files with special characters in them (i.e. # and ?) can be opened in the viewer.
· Fixed so the list of files which will be deleted and the list of files which could not be deleted can be resized.
· Fixed so the list of files which will be deleted and the list of files can be saved to a file or copied to the

clipboard.

8.1.2 Version 2.21
· Fixed error on startup which happened occasionally on Windows machines.
· Sped up closing zsDuplicateHunter if zsDuplicateHunter is closed while a duplicate hunt is in progress.

8.1.3 Version 2.20
· Added the ability to run zsDuplicateHunter on the Linux operating system.
· Split zsDuplicateHunter into Standard and Professional editions.
· Added three new grouping options - Group Files by Path, Group Files by Extension, and Group Files by

Timestamp.
· Added the option to filter files by file size. This option allows the user to find 0 size files, or to only find larger

duplicate files.
· Added help messages while running the program to help explain common questions and to make the process

easier to understand.
· Added a list of all the methods of deleting files to the bottom of the screen with explanations of what each

method does.
· Added support for saving and loading sessions to zsDuplicateHunter. These can be used to save and reload

commonly used duplicate hunts.
· While a duplicate hunt is running, zsDuplicateHunter will now calculate the estimated time remaining for the

duplicate hunt to complete.
· Added the total size of files that have been searched to the status bar.
· Added the ability to save the results of a duplicate hunt to XML for use in other programs, or for archival

purposes.
· Added the ability to drag files from the results to the Windows Explorer and Finder.
· Added the ability to customize font sizes within HTML reports.
· Added the ability to ignore Windows Shortcuts when running a duplicate hunt.
· Added an option to disable the delete warning when a folder is deleted within zsDuplicateHunter.
· Added a Set Filters button next to the grouping options to make the filters easier to access.
· Added a warning if checksum and digest are both off or both on.
· Added tool tips to all grouping options to give more information about what each option does.
· Made expanding and collapsing groups faster.
· Added the ability to remove a license from a machine so a license can be transferred between machines.
· Expanded the Ignore Folder Aliases functionality to also recognize aliases of files under OS X.
· Changed to prompt the user if changes should be saved when the options dialog is closed using the close box.
· Fixed so the warning when deleting files and folders is not larger than the screen if files with long filenames

are being deleted.
· Fixed the calculation of Checksums for files that were within a Zip file when the Adler32 method is used to

calculate checksums.
· Fixed errors when searching within the results and the direction was set to "Search Up".
· Fixed so that when a file is located within a zip file it is grouped correctly when grouping by name.
· Fixed so running duplicate hunts under Tiger is significantly faster when ignoring aliases is turned on.
· Fixed so the close button on the Tip of the Day Dialog is visible under Mac OS X.
· Fixed so the Input Buffer Size is saved when the program is closed and restarted.
· Fixed error when dragging a file to the list of folders to be searched.
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8.1.4 Version 2.13
· Added an option to automatically remove unique files from the results after running a duplicate hunt to

minimize the amount of memory needed and to help prevent the accidental deletion of unique files.
· Changed Delete To Folder location to not be directly editable to ensure that valid locations are selected.
· Added the ability to open the Delete to Folder location in Windows Explorer or Finder from the Options

dialog to make it easier to recover files if needed.
· Made browse dialog for browsing for the delete to folder location a modal dialog so it cannot get stuck behind

the options dialog.
· Added the ability to set the read buffer to allow user to assist in optimizing the speed of duplicate searches.
· Fixed an over-reporting of the number of duplicates when files were duplicates and unique files had similar

sizes.
· Modified the progress display to be more fluid and to format the number of files that have been checked better.
· Did additional speed improvements while doing duplicate hunts and deleting files.

8.1.5 Version 2.12
· Added indicators to the left of the results to indicate which groups can and cannot be expanded. Clicking on

the indicator will expand the group. On Windows systems, the indicator is a plus or minus symbol. On
Macintosh systems, the indicator is an arrow.

· Added a new warning message when a folder is about to be deleted which would delete all of the files in the
folder.

· Fixed fatal error that could occur when all copies of a file were about to be deleted.
· Fixed fatal error that occasionally occurred when deleting files from the desktop on Windows systems.
· Prevented the program from freezing under Mac OS X under special conditions when selecting the folder to

delete to.

8.1.6 Version 2.11
· Added a display of files that were skipped because the file could not be read while calculating a checksum or

digest.
· Added the ability to remove system files from the list of files to be searched under OS X. System folders

include /bin, /cores, /dev, /etc, /private, /sbin, /tmp, /usr, and /var.
· Filtered aliased files from the selection tree under Mac OS X to aviod recursive searches that never ended.
· Added validation of regular expressions so that the regular expression can be corrected instead of getting a

fatal error.
· Added new feature where files are displayed in the status bar while they are being deleted. This helps you to

see the progress of a deletion.
· Added the ability to drag a folder onto the selection tree from Finder or Windows Explorer.
· Improved responsiveness of zsDuplicateHunter while deleting files.
· Added number of files being deleted to warning message when files will be permanently deleted.
· Limited number of files or folders that can be opened at one time to 20 files and folders.
· Prevented changing options while a duplicate hunt was being run which could cause zsDuplicateHunter to

hang.
· Set the default directory on startup of new installs to the users home directory.
· Set the default trash directory on startup of new installs to a trash directory under the users home directory.
· Swapped delete all but newest and delete all but oldest so they are not reversed.
· Added error checking for invalid filenames when saving reports.
· Made deleting of zip files and jar files faster.

8.1.7 Version 2.10
· Added the ability to group files by digest including MD5, SHA-1, SHA-256, SHA-384, and SHA-512.

Grouping by digest is more accurate than grouping by checksum, but it is slower.
· Sped up searching for duplicates and reduced the memory usage when a large number of files were being

compared and many duplicates existed.
· Improved speed when deleting duplicate files and ignoring files.
· Added the ability to delete selected files by pressing the delete key.
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· Added the ability to preserve the directory structure where the file is deleted with the Delete To Folder option
to make recovery of files that were accidentally deleted easier.

· Added the ability to ignore aliased folders when searching for duplicates to make the results easier to
understand.

· Moved options for filtering files to the options dialog to allow additional room for viewing results and to make
the program easier to understand for new users.

· Removed limitation on number of files that can be searched in the trial version.
· Added new functionality so zsDuplicateHunter will remember where it was located on the screen after it has

been closed.
· Fixed filtering of files by name within zip files and jar files.
· Fixed problem opening files and containing folders when a group of files was selected.
· Fixed so zsDuplicateHunter correctly remembers the setting for ignoring hidden files.
· Fixed error loading icons if the underlying operating system encountered an error loading the icon.
· Added the ability to print system diagnostics to the about screen.

8.1.8 Version 2.01
· Added the ability to filter files to search by the full path of the file in addition to the display name for finer

control.
· Improved the speed when ignoring files and folders in the results.
· Fixed problem where all copies of a file could be deleted when doing a Delete All Except Newest or Delete

All Except Oldest Command on a directory which contained multiple duplicates of a file.
· Updated status bar after zsDuplicateHunter finishes deleting duplicate files.

8.1.9 Version 2.00

Display Duplicates by Path
Added the ability to display duplicates by path in addition to the ability to display duplicates by group. This
allows you to view the files as they exist on your system. Key features include:
· Summary information is displayed for each folder including number of files and sub folders within the folder

and the number of files and subfolders that have duplicates.
· The number of duplicates for each file is listed after the filename.
· Duplicate files are displayed each file so they can be easily deleted.
· Duplicate files are displayed below the file as it exists on your computer.
· Summary information is automatically updated when files are deleted.
· Switch between displaying duplicates by path and displaying duplicates by group without running a new

duplicate hunt.

File Deletion Changes
Added 6 new methods of deleting files as well as several options to aid in deleting files.
· Added the ability to delete all but the newest file in a group of duplicates.
· Added the ability to delete all but the oldest file in a group of duplicates.
· Added the ability to delete all but the first file in a group of duplicates.
· Delete All Duplicates of File lets you easily remove duplicates for a single file.
· Keep Files In This Folder, Delete Duplicates Elsewhere option lets you easily remove all files in a folder

which have duplicates elsewhere.
· Delete All Files In This Folder Which Have Duplicates option lets you easily remove all files in a folder which

have duplicates elsewhere.
· New deletion options include a warning if all occurrences of a file are about to be deleted.
· Added the ability to automatically delete a folder after all of the files in it have been deleted. You can also

determine whether or not to treat folders that only have hidden files as empty.
· When a file or folder cannot be deleted, a list of the files that cannot be deleted is displayed.
· Fixed error stating that a file could not be deleted when it had already been deleted outside of

zsDuplicateHunter.
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Display of Timestamps
· Added timestamps to the display of duplicate results. This can help to determine which duplicate files should

be preserved.
· Added the ability to customize the display of timestamps.

Opening Files and Folders in Viewers

· Added the ability to open folders in a viewer.
· Added the ability to open the folder that contains a file or folder in Windows Explorer or Macintosh Finder.
· Added the ability to open all folders which contain duplicates in Windows Explorer or Macintosh Finder for a

selected group.
· Changed opening files and folders in viewer to automatically open all files and folders that are selected rather

than the currently selected item.

Other Enhancements and Error Corrections.
· Added the ability to Ignore Files and Folders to make cleaning up duplicate files easier and safer.
· Added the ability to sort files within duplicate groups by name or by the date they were last modified.
· Made results table scroll horizontally which can make it easier to view the paths of duplicate files.
· Added the ability to access options using the zsDuplicateHunter|Preferences menu on Mac OS X.
· Added system information to the About Dialog including Java version in use and information about memory.
· Added the ability to send feedback and submit problems from within zsDuplicateHunter. These features can be

accessed from the Help menu.
· Fixed error in the trial version which caused zsDuplicateHunter to report that the maximum number of files

had been reached after searching a folder with more than the maximum number of files and then searching a
folder with less files.

· Fixed an occasional error which could cause the trial version of zsDuplicateHunter to lock up after searching
for duplicate files when the maximum number of files is reached.

· Fixed error which could cause folders within zip files to be listed twice if they were listed incorrectly in the zip
file.

8.1.10 Version 1.22
· Removed restriction of not being able to save html reports in the trial version.
· Increased the number of duplicate files that can be searched in the trial version from 3000 to 6000.
· Added display of grow box in Mac OS X version to make resizing zsDuplicateHunter easier.
· Increased the default size of zsDuplicateHunter to 1024x768 or the size of the screen which ever is less.
· Fixed very rare error which caused zsDuplicateHunter to sporadically fail on startup.

8.1.11 Version 1.21
· Added the Adler32 method of calculating checksums which is faster than CRC32 checksums, but slightly less

reliable.
· Added the ability to show a warning prompt when a file is about to be permanently deleted.
· Prevented zsDuplicateHunter from repeatedly searching the same directory multiple times which could lead to

zsDuplicateHunter running out of memory.
· Added additional checking to detect if zsDuplicateHunter has run out of memory while running duplicate

hunts and reduced the amount of memory needed to run zsDuplicateHunter.
· Fixed sorting of files and folders while selecting folders to ignore filename case.
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8.1.12 Version 1.20
· Added the ability to save HTML reports of duplicate hunt results. Primary features include:

· Customizable header and footer text can be added to the report.
· The report can include either only visible results or all results.
· The report can optionally include the options used to generate the results.
· The report can optionally include the directories searched to generate the results.
· Date generated can be included.
· Title of the report can be customized.

· Added the ability to filter which files and/or folders to include or exclude specific items from being searched.
· Fixed so viewers for files with spaces in the path can be opened from within zsDuplicateHunter on Mac OS X.

8.1.13 Version 1.11
· Fixed error when a duplicate hunt was started while another duplicate hunt was already in progress.
· Fixed appearance of zsDuplicateHunter at 640x480 screen resolution on Windows machines.
· Fixed button images on options dialog for selecting which folder to delete to.
· Fixed creating directories that require multiple directories to be created when deleting to files.
· Added warning message when deleting duplicates if one or more files could not be deleted.

8.1.14 Version 1.10
· Added the ability to search within the results of a duplicate hunt. Searching includes the following primary

features.
o Find next match only, or find all matches and jump between them.
o Ability to match or ignore case and to match entire words only.
o Find dialog remembers last searches performed.
o Search forward and backwards.
o Ability to seach using regular expressions.

· Added the ability to ignore system files while searching for duplicates.
· Added the ability to ignore hidden files while searching for duplicates.
· Added additional checking to ignore checking crc for files that cannot be opened due security permissions or

due to the file being opened by another application.

8.1.15 Version 1.00
The initial release of zsDuplicateHunter which includes support for grouping duplicate files by any combination
of name, size, and CRC. Version 1.0 also allows you to delete files either permanently or to a backup folder.

8.2 Checking for Updates
When you purchase zsDuplicateHunter from Zizasoft, we allow you to download many updates to
zsDuplicateHunter for free.  To ensure that you are always working with the latest version, our products offer
you the ability to check for updates from within the program either manually or automatically.

Check For Updates Dialog

Manually checking for updates
To manually check for updates from within a program, select the Check for Updates menu item within the Help
Menu. You will then need to select the Check Now button.
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This command contacts the Zizasoft server to determine if any updates are available for your program. If there
are updates, information about the new features will be displayed with information on how to download the new
version.

Automatically checking for updates
To schedule a program to check for updates automatically, select the Check for Updates menu item within the
Help Menu and set the Frequency to anything other than Never. We try release new versions of our products
three to four times each year. Therefore, we suggest that you set the update check to once a week or once a
month.  ZsDuplicateHunter will now automatically check for available updates each time you start the program
(unless you are running zsDuplicateHunter using the command line interface).

Note: Checking for updates does not send any personally identifiable information to Zizasoft.

8.3 Sending Feedback to Zizasoft
Our users are extremely important to us and we want to make sure that we are serving your needs completely. If
you have suggestions for improving our programs, would like to see us change existing functionality, or just have
general comments for us, please use the Send Feedback menu item in the Help Menu to send us your feedback.

Note, Sending Feedback requires an Internet connection.  If you prefer, you can also send feedback directly from
our website http://www.zizasoft.com.

8.4 Problem Reports
We do extensive testing of our products and we believe the quality of our products is among the best in the
business.  However to ensure that your usage of our programs is trouble free and that you get the most out of
them, we offer free support to registered users as well as users working with the trial version.

In the unlikely event you have a problem with one of our programs, first check for updates to determine if a new
version is available. If there is not an update available which corrects your problem, please contact us using the
Report Problem item within the Help Menu.  Please include a full description of the problem you are
encountering as well as which program you are using and the version of the program.

Note, Sending a Problem Report requires an Internet connection.  If you prefer, you can also send feedback
directly from our website http://www.zizasoft.com.

8.5 How to contact us

Website: www.zizasoft.com
Address:
21684 Swale Ave.
Parker, CO 80138
Support e-mail: support@zizasoft.com
Sales e-mail: sales@zizasoft.com
Telephone: 1 (303) 638-9235
Fax: 1 (720) 862-2089
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9 Acknowledgements

JConfig
ZsDuplicateHunter utilizes JConfig from Samizdat Productions. JConfig is Copyright 1997-2000
Samizdat Productions. All Rights Reserved.

Java Chart Construction Kit (JCCKit)
ZsDuplicateHunter utilizes JCCKit which is distributed under the GNU Lesser General Public License.  More
information about JCCKit can be found at http://jcckit.sourceforge.net/index.html.  You can find the full text of
the GNU Lesser General Public License at http://www.gnu.org/copyleft/lesser.html. 

MacBinary Toolkit 2 for Java
ZsDuplicateHunter utilizes the MacBinary Toolkit 2 for Java which was developed by Greg Guerin.  Mac
Binary Toolkit 2 for Java is licensed under the Artistic license.  More information about the MacBinary Toolkit
for Java can be found at http://www.amug.org/~glguerin/sw/macbinary/index.html.  You can find the full text of
the Artistic License at http://www.opensource.org/licenses/artistic-license.php. 

Quaqua
ZsDuplicateHunter utilizes the Quaqua Look And Feel which was developed by Werner Randelshofer.  The
Quaqua Look and Feel is distributed under the Modified BSD License.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

   1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
   2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
   3. The name of the author may not be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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10 License Agreement

ATTENTION:  PLEASE READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THIS
PACKAGE.  THE INDIVIDUAL OR ENTITY INSTALLING THIS PACKAGE (THE "END USER")
AGREES TO BE BOUND BY THE TERMS OF THIS LICENSE.  IF YOU INSTALL THIS PACKAGE AND
DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE SOFTWARE AND
PROMPTLY RETURN THE SOFTWARE, AND THE LICENSE PRICE WILL BE REFUNDED.
The enclosed computer program(s) and the accompanying documentation are provided to the End-User by
Zizasoft,LLC ("Licensor") for use only under the following terms.  Licensor reserves any right not expressly
granted to the End-user.  The End-User owns the disk on which the Software is recorded, but Licensor retains
ownership of all copies of the Software itself.  The End-User assumes sole responsibility for the installation, use
and results obtained from use of the Software.
 

1.  License.
End-User is granted a limited, non-exclusive license to do only the following:
A.  Install and maintain the Software on one or more computers for usage by one individual provided that the
Software will not be in use on more than one computer at the same time.
 
B.  Make one copy in machine-readable form solely for backup or archival purposes for the computer which the
Software is installed.  The Software is protected by copyright law.  As an express condition of this License, the
End-User must reproduce on the copy Licensor's copyright notice and any other proprietary legends on the
original copy supplied by Licensor.
 
C.  Transfer the Software and all rights under this License to another party together with a copy of this License
and all written materials accompanying the Software, provided (i) the End-User gives Licensor written notice of
the transfer (including in such notice the identity of the transferee), and (ii) the other party reads and agrees to
accept the terms and conditions of this License.
 

2.  Restrictions.
The End-User may NOT sublicense, assign, or distribute copies of the Software to others.  The Software contains
trade secrets.  The End-User may NOT decompile, reverse engineer, disassemble, or otherwise reduce the
Software to a human readable form.  THE END-USER MAY NOT MODIFY, ADAPT, TRANSLATE, RENT,
LEASE, LOAN, RESELL FOR PROFIT, DISTRIBUTE, OR OTHERWISE ASSIGN OR TRANSFER THE
SOFTWARE, OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY PART
THEREOF, EXCEPT AS EXPRESSLY PROVIDED IN SECTION 1.C. ABOVE.
 

3.  Protection and Security.
The End-User agrees to use its best efforts and to take all reasonable steps to safeguard the Software to ensure
that no unauthorized person shall have access thereto and that no unauthorized copy, publication, disclosure or
distribution in whole or in part, in any form, shall be made.  The End-User acknowledges that the Software
contains valuable confidential information and trade secrets and that unauthorized use and/or copying are
harmful to Licensor.
 

4.  Termination.
This License is effective until terminated.  This License will terminate immediately without notice from Licensor
if the End User fails to comply with any of its provisions.  Upon termination the End User must destroy the
Software and all copies thereof, and the End-User may terminate this License at any time by doing so.
 

5.  Limited Warranty.
Licensor warrants that, for one year from the date of initial use by the original End User, the Software shall
operate substantially in accordance with the published functional specifications current at the time of shipment. 
If, during the warranty period, a defect appears, End User shall return the Software to Licensor and Licensor's
only obligation shall be, at Licensor's election, to replace the defective Software or refund the purchase price. 
The End-User agrees that the foregoing constitutes the End-User's sole and exclusive remedy for breach by
Licensor under any warranties made under this Agreement.  This warranty does not cover any Software that has
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been altered or changed in any way by anyone other than Licensor.  Licensor is not responsible for problems
associated with or caused by incompatible operating systems or equipment, or for problems in the interaction of
the Software with software not furnished by Licensor.
 
No oral or written information or advice given by Licensor or its dealers, distributors, employees or agents shall
in any way extend, modify or add to the foregoing warranty.
 
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL
OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE END-
USER ASSUMES ALL RISK AS TO THE SUITABILITY, QUALITY, AND PERFORMANCE OF THE
SOFTWARE.  IN NO EVENT WILL LICENSOR, OR ITS DIRECTORS, OFFICERS, EMPLOYEES OR
AFFILIATES, BE LIABLE TO THE END-USER FOR ANY CONSEQUENTIAL, INCIDENTAL, INDIRECT,
SPECIAL OR EXEMPLARY DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF DATA OR BUSINESS INFORMATION, AND THE LIKE)
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE OR ACCOMPANYING
WRITTEN MATERIALS, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.
 
LICENSOR'S LIABILITY TO THE END-USER (IF ANY) FOR ACTUAL DIRECT DAMAGES FOR ANY
CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF THE ACTION, WILL BE LIMITED TO,
AND IN NO EVENT SHALL EXCEED, THE AMOUNT ORIGINALLY PAID TO LICENSOR FOR THE
LICENSE OF THE SOFTWARE.
 

6.  Enhancements.
From time to time Licensor may, in its sole discretion, advise the End-User of updates, upgrades, enhancements
or improvements to the Software and/or new releases of the Software (collectively, "Enhancements"), and may
license the End-User to use such Enhancements upon payment of prices as may be established by Licensor from
time to time.  All such Enhancements to the Software provided to the End-User shall also be governed by the
terms of this License.
 

7.  General.
This License will be governed by and construed in accordance with the laws of the Colorado, and shall inure to
the benefit of Licensor and End-User and their successors, assigns and legal representatives.  If any provision of
this License is held by a court of competent jurisdiction to be invalid or unenforceable to any extent under
applicable law, that provision will be enforced to the maximum extent permissible, and the remaining provisions
of this License will remain in full force and effect.  Any notices or other communications to be sent to Licensor
must be mailed first class, postage prepaid, to the following address: Zizasoft, LLC 21684 Swale Ave. Parker,
CO 80138.
 
This Agreement constitutes the entire agreement between the parties with respect to the subject matter hereof,
and all prior proposals, agreements, representations, statements and undertakings are hereby expressly canceled
and superseded.  This Agreement may not be changed or amended except by a written instrument executed by a
duly authorized officer of Licensor.
 

8.  Acknowledgment.
BY INSTALLING THIS PACKAGE, THE END-USER ACKNOWLEDGES THAT IT HAS READ THIS
LICENSE, UNDERSTANDS IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. 
Should you have any questions concerning this License, contact Licensor at the address set forth above.
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